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This chapter introduces the Connection Manager and explains how to configure the server 10, access the client's user
interface, connect instruments, and customize and save the Connection Manager configuration.

Overview

Connection Manager is the ADS implementation of Agilent Technologies Connected Solutions.

Connected Solutions encompasses the integration of ADS software and specific Agilent instruments (signal generators
and signal analyzers) into a solution that enables new design and verification capabilities. It combines simulation and
measurement, and allows the seamless sharing of signals, measurements, algorithms, and data between the
simulation and measurement domains.

Using Connection Manager, you can:

e access and control instruments from ADS dialogs

e measure devices and construct ADS datasets from the measurement data

e create simulation models based on measured data

e use real-time instrument-generated stimulus and measurement during simulations

Connection Manager consists of two parts:
e Connection Manager Server
Connection Manager server provides dynamic access and control of remote instruments and IO diagnostics.

Refer to Connection Manager Server for more information.

B Note

One critical customer issue is that certain newer Dell Precision PCs have a problem with their "Bluetooth Stack
for Windows by Toshiba" that conflicts with installing the Connection Manager Server.

e When the CM Server is installed on such PCs, the PC will crash and will require a reimage of the PC.

e This is a problem inherent with the Toshiba driver.

e The work around to use the "Agilent Connection Manager" is to uninstall the "Bluetooth Stack for
Windows by Toshiba".

¢ Although the Bluetooth Stack for Windows by Toshba is uninstalled, XP still provides a Bluetooth
capability. So, the Bluetooth is still there.

e Connection Manager Client

The Connection Manager client provides the interface between ADS and the Connection Manager server's functionality
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and extensibility. The client allows the ADS user to dynamically manage data, configure the server, control input and
output, and make device measurements.

Refer to Connection Manager Client for more information.

Configuring the Server IO on the PC

Prior to using Connection Manager for the first time, you must configure the IO on the server workstation.

This section provides instructions for automatically configuring common LAN and GPIB interfaces, and for manually
configuring other interfaces such as LAN/GPIB gateways.

To Configure Common LAN or GPIB Interfaces provides simplified instructions to configure a common LAN or GPIB
interface.

To manually configure an available interface (for example, the Agilent E5810A LAN/GPIB gateway), see To Manually
Configure Other Interfaces.

Using the Agilent IO Libraries Version M versus Agilent IO Libraries Suite

The Connection Manager supports the latest version of the IO Libraries, the Agilent IO Libraries Suite . If you have
installed the IO Libraries Suite before installing the Connection Manager server, the server installer will not overwrite
that installation with an old version of the IO Libraries (otherwise, it would install the older version by default).

The CM client window will recognize the new version and display the status information accordingly. The diagnostics
will recognize the new 10 Libraries version, although the new version identifies itself in the registry with an unusual
version string.

If the Agilent 10 Libraries Suite is not previously installed or the existing installation is insufficient for the CM's needs,
the CM server installation will continue to install the Agilent IO Libraries Version M (version M.01.01.04).

© Note

For systems configured with the ADS 2004A CM server, the server will provide instrument IO using the new IO
Libraries Suite. However, the ADS 2004A CM server window will display a red status in the server's Required
Conditions field due to a change in the Agilent IO Library registry name. Starting with the Agilent IO Libraries
Suite 14 release, the Windows Registry naming structure was changed from previous IO Libraries version
alpha-numeric format (M.01.01.04) to a numeric format (78.0.7202.1), resulting in the false red status.

To Configure Common LAN or GPIB Interfaces
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Follow the instructions in this section to auto-configure the IO and connect instruments to the server using a LAN or
GPIB interface.

1. In the server's Windows system tray, select IO > Run IO Config .
This opens the I0 Config dialog. The Available Interface Types group box lists the I0 types supported by the
Agilent IO Libraries. List entries with and asterisk ( * ) can be automatically configured in step 2.

2. To automatically configure common LAN and GPIB interfaces in the I0 Config dialog, select Auto Config .
Auto-configured interfaces appear in the Configured Interfaces group box, as shown.

Agilent 1O Libraries Configurnation - 10 Config E|rﬁ|rg|
File ©Options Help

|0 Config configures and editz Agilent |0 interfaces.

- To configure a new interface, select the interface in ‘Available Interface Types' and chick 'Configure’
- To edit a configured interface, zelect the interface in ‘Configured Interfaces’ and click 'Edit’

- To automatically configure the interfaces identified with ™, click ‘Auto Config'

Available Interface Types Configured Interfaces
VISA Type  Interface Descrphion VISA Mame  SICL Mame
ASRL *HE-232 COM Ports - GRIBO agpibl * Auta Config
ASRL IS4 LAM Client [e.g. ES8 M
GFIE *32380 PCl GPIE Card
GPIE “GPIE Using NI-488.2 USED usbl oK |
GFIE 82341 154 GPIB Card
GFIE 82357 USE to GPIB
GRIE VIS4 LAN Client (2.0 E5S Help |
GRIBA] GBS Command Modu
TCRIF *LéM Clent [LAM [nstrume
I15E *USE Instruments
ISE WISA LAN Clent for ISE
Wl *EB497 [EEE-1394 ta Wil
n'a L&M Server [PC az Server ™

B | Benove

*MOTE: Auto Config will configure interfaces identified with an

If you encounter a problem

For GPIB interfaces, ensure that the GPIB interface is installed/connected to the server.
For LAN interfaces, the 10 auto-configuration routine creates a TCPIP network tunnel and displays TCPI P | an in the
Configured Interfaces group box. The routine creates only one TCPIP interface regardless of how many LAN cards are

installed on the server workstation. Follow the steps in To Connect Instruments to the Server through the LAN to
complete the LAN interface configuration.
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To Connect Instruments to the Server through the LAN

Unlike GPIB interfaces where instruments communicate directly with the server via an exclusive bus, the Agilent IO
libraries do not dynamically discover instruments connected to the server via LAN. You must manually add LAN

devices to the server IO.

To add LAN devices, complete the following steps.

AN

In the IO Config dialog, highlight TCPIPO in the Configured Interface group box and click Edit .
In the LAN Client dialog, click Edit VISA Config .

In the TCPIP devices dialog, click Add device .
In the Add a TCPIP device dialog Machine Name/IP field, enter the IP address of the instrument you would like to

connect to the server and click OK .

LAN Client

Questions? Press the Help button below,
Recommended default values are shown,

SICL Interface Mame:

TCPIP devices Add a TCPIP device

Enter the address of this device: ok, I
Logi TCAIPg Machine Mame/IF Device Name
Server | [ TCRIPD: [21253243699 ¢ | JINSTR Carcel |
Client Timeod |TEF‘IF‘U::E'I 2.53.243.699::inst0 2INSTR
v
W Log Enors Add device
— 1
a Femove device
.
.

5. In the TCPIP devices dialog, click OK .
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LAN Client X

[Huestions? Press the Help button belowvs.
A ecommended default values are shown,

SICL Interface Mame: [|apn ] 4 |
VIS4 Interface Mame: [TCRIPD il

TCPIP devices

X]

TCPIPDINSTR devices present: )4 I: |
TCPIPO: 21253, 243 699 instl: INS TR
Cancel |

Add device

Remaove device

6. In the LAN Client dialog, click OK .
7. In the IO Config dialog, click OK .

If you encounter a problem

Ensure the following conditions are met:

The server is connected to the LAN.

The instrument is connected to the LAN.
The instrument line power is switched on.
The LAN is operational.

To start the Connection Manager client, see Accessing the Client From a Schematic Page.

To Manually Configure Other Interfaces

This section explains how to manually configure an IO that cannot be auto-configured by the Agilent IO Library. This
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section explains how to configure a LAN/GPIB gateway, such as the Agilent E5810A. Follow the screen prompts to
manually configure your installed interface.

Follow the instructions in this section to manually configure a LAN/GPIB gateway.

1. In the Windows system tray, select IO > Run IO Config .

N

In the Available Interface Types group box, highlight VISA LAN Client Interface (E5810A) and click Configure .

3. In the VISA LAN Client Interface (LAN to GPIB) dialog Local Settings group box, use the scroll box to choose a
VISA Interface Name.

4. In the Remote Settings group box, enter the hostname or IP address of the LAN/GPIB gateway.

5. In the Remote Settings group box, enter the SICL interface name assigned to the LAN/GPIB gateway (or other
network interface device) and click OK .
During the process of configuring the LAN/GPIB gateway, you must assign a SICL interface name to the device.
You must enter the same SICL interface name in the Remote SICL Interface Name data entry field.

Agilent 10 Libraries Configuration - 10 Config

File Options

VISA LANClient Interface (LAN to GPIB)

EEX

|0 Config configures and edits Agilent 10
- To configure a new interface, select t
- To edit a configured interface, select |

- To automatically configure the interfag

Awailable Interface Types

WVISA Tupe

|nterface Descrption

ASHL
ASAL
GFIE
GFIE
GFIE
GFIE

GBI
TCFIP
5B
5B
"Wl
n'a

*R5-232 COM Ports
W54 LaM Client [e.g. §
*82350 PCI GPIE Card
*GPIB Uszing MI-423.2
32341 154 GPIB Card
32357 JSE to GRIB
WISA LAN Client [e.g. |
GPIB-I Command M
“LaM Client [LAM Tnstr
*USE Inztruments

[ueztions? Press the Help button below, Recommended default values are shown,

i Local Settings

WISA Interface Mame: |I3 FIB3

LAM Client SICL Interface Mame: Jlan

~ Remate Settings
The remote SICL interface must be a GPIB interface.

Remate Haosthame

o IP Addrese | |169.254.178.34

Remate SICL Interface M arme: IQF'":'D

oK

Cancel

Help

443:

Defauilts

VIS4 LAM Client for U3

*E8431 [EEE-1334 to =]

LAM Server [PC az Server ™

*MOTE: Auto Config will configure interfaces identified with an ™'

6. In the VISA LAN Client Interface (LAN to GPIB) dialog, click OK .
To exit the IO configuration without connecting instruments to the server, in the I0 Config dialog click OK . To
connect instruments to the server, follow the steps in To Connect Instruments to the Server through the LAN.

To start the Connection Manager client, see Accessing the Client From a Schematic Page.

10



Advanced Design System 2008

If you encounter a problem

Ensure the following conditions are met:

e The server is connected to the LAN.
e The LAN is operational.

Accessing the Client From a Schematic Page

1. From the ADS Main window open or create an ADS project.

2. From an ADS Schematic window, select Tools > Connection Manager Client ... .
This opens the Connection Manager Client main window. When the client starts, the Getting Started dialog is
displayed, as shown.

E.&gﬂent Connection Manager Client

File Server Instruments Measuremerts ‘Window Help

E Connection Manager Client @E|

Gedting Started

Tozet a default zerver, select ServessSet Server.

To access instruments, select Instruments: Femate [nstrument Explorer.

To acces: a measuement, select the Meaturements menu

[T Don't show this dislog box again

Carcal e |

3. To dismiss the Getting Started dialog, click OK .
Selecting the Don't show this dialog box again checkbox prevents this dialog from appearing again.

Selecting a Server Workstation and Connection Port

The Connection Manager client requires TCP/IP network connectivity to a computer running the Connection Manager
server.
To specify a machine as the Connection Manager server, follow these steps.

11
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1. From the Connection Manager Client main window, select Server > Set Server... .
This opens the Set Server dialog. Use this dialog to connect the client to a specific port on a specific server for
the remainder of the client session. Values entered in the Server Host Configuration group box specify the
workstation running the Connection Manager server.
UNIX and Linux Systems PC Systems
—| Set Server | B3 set Server EHE
- Server Host Configuration — Server Host Configuration
Enter the server IF address or DS name ® Connect bo ssrver on this Windows PC
ISeruer IP address or host name] " Connect to server on remate Windows PC
Server IP addiess or DNS narme
— Server Port Configuration localhost
“4 Connect to server on default port
- Server Port Configuration
~ Connect to server on non-default port f* Connect to server on default port
Server port # ™ Connect to server on non-default port
[4790 Server port #
4730
_| Do not prampt me again
[ Do not prompt me again
Dk | Cancel Help oK Cancel Help
2. Enter an IP address or a DNS (host) name in the upper data entry field and click OK .
An IP address takes the form of a series of period-separated numeric entries representing a workstation, such as
162. 156. 24. 58 .
& Hint
You can find the IP address of a Windows workstation by typing the command i pconfig -all into a command
line window.
You can also specify the server using either the short form or fully qualified DNS (Domain Name Server) host
name. If the client and server workstations have been configured to do so, you can use the short form of DNS
name. For example you may wish to use myserver , the short form of the fully qualified DNS name
myserver.mycompany.com .
B Note

You can find the server workstation host name
by typing the command hostname into a command window.

For clients on PC platforms, the default server entry is localhost (specifying the client and server on the same PC
workstation). On other platforms, the Server IP Address or DNS Name entry field is undefined by default.

The default port is 4790. For information on how to change the port number refer to Connection Manager Server.

12
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Discovering Connected Hardware

All instruments must connect to or through the server workstation. The Remote Instrument Explorer dialog provides
information about the server workstation.

For PC-based systems, the Connection Manager client and server commonly reside on the same physical machine.
Because of this, instrument configuration may take place on the same workstation that the client resides.

B Note

If you have not already done so, follow the steps in To Configure Common LAN or GPIB Interfaces to configure
your Agilent IO Libraries.

1. To access the Remote Instrument Explorer dialog from the Connection Manager Client window, select
Instruments > Remote Instrument Explorer... .

2. Enter the DNS host name or IP address of the workstation on which the Connection Manager server is running.

3. If the default port number is not being used, enter the port number on which the server listens for incoming
requests.

© Note

By default the port humber is 4790. For information on changing the port refer to Understanding I0
Configuration.

4. Select OK to access the Remote Instrument Explorer dialog.

E Agilent Connection Manager Client EIEI E|

File Server Instruments Measurements ‘Window Help

Remote Instrument Explorer - port 4730 -1ol x I

Server ||D'3~3|h'2'3t14?9|:| Refiash | Duery S elected Instiuments’ ID: | Query &l Instruments' |Dg | Help |

Y154 Resource | Instrurnent 1D |
GRIBO:14:INSTR
GFIBD:1S:INSTR
GRIBO:E:INSTR
GRIBO:1E:INSTR
GPIBO:19:INSTR
GRIBO:7:INSTR

This dialog box shows the VISA (Virtual Instrument Software Architecture) Resource identifiers of all instruments that
are currently connected to the workstation running the Connection Manager server. A VISA Resource identifier can
uniquely identify an instrument among all the instruments connected to the workstation through all available

13
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interfaces.
To map the VISA Resource identifiers to the associated instrument model number, click Query All Instruments' IDs .

This instructs the Connection Manager server to send *IDN? (the IEEE 488.2 standard command for instrument
identification) to all instruments on the bus.

B Note
Some older instruments cannot respond to *IDN? and show an error, usually a time out, in the Instrument ID

field.

E Agilent Connection Manager Client

File Server Instruments Measurements ‘Window Help

Remote Instrument Explorer - port 4730 - 1ol % l

Server ||':"3~3|h'3'3t14?9|:| Refrazh | Queery Selected Instruments’ IDs | Query &ll Instuments' IDs,l Help |

|

| N

W54 Resource | Instrument |D

GPIBO:T4:INSTR  Agilent Technolagies, 8753 ,0.7.14

GPIBO:1S:INSTR VI_ERROR_TMO: & timeout accurted

GPIBO:TE:INSTR  Agilent Technologies E 83584 USA021 00244 04 25

GPIBO:18:INSTR  Agilent Techrologies E 44064 US41152605,404.21 20000921 10421
GPIBO:19:INSTR  Agilent Techrologies. ESG-D4000B, MY41000133. B.03.75
GRIBD:7:INSTR  Aglent Technologies 548320 MY 42000431 1.02.25 R,080

i JProgram Files)Agilent /Connection Manager Server IO Config. xml

Five instruments (and one printer pass-through at address 15) have been discovered on the GPIBO interface.

B Note

Though the VISA Resource column lists the instruments resource identifier syntax, it is not necessary to
remember these VISA identifiers. The measurements that use these instrument resource identifiers display

them in a drop-down list within the measurement panels.

To repopulate the list after adding or removing instruments from the server, click Refresh .

Customizing Instrument Identification Strings

File-based instrument discovery allows you to apply your own identification string to instruments displayed in the
Remote Instrument Explorer dialog. This IO configuration file can be configured on either the client workstation

(I0Config.iml) or the server workstation (I0Config.xml).
The Connection Manager server will attempt to populate the Instrument Explorer in the following order:

1. With the contents of the $HOME/hpeesof/Config/IOConfig.iml (the client-based configuration file)

14



Advanced Design System 2008

2. With the contents of the <CM server installation directory>/IOConfig.xml (the server-based configuration file)
3. With dynamically discovered instruments connected to the server.

Client-Based IO Configuration

Instead of the server querying the IO for connected instruments or the contents of a server-side user-defined XML file,
the server queries a file on the client workstation and displays the results in the Remote Instrument Explorer dialog.

The VISA libraries do not have the capability to dynamically discover instruments through the TCPIP entry in the I0
Libraries IO Configuration database. Using file-based instrument discovery allows the Remote Instrument Explorer
dialog to list network-connected instruments that would otherwise not appear.

This configuration is useful for installations where many clients are connected to a single server. Using a client-side
configuration allows for a smaller list of selectable instruments than are physically present on the server, making it
possible to tailor the Instrument Explorer to display on the instruments of interest to a particular user.

B Note

When using file-based instrument discovery, no instrument communication takes place during the discovery
process.

This procedure modifies and then references the I0Config.iml file on the client computer for instrument discovery.

1. In the Connection Manager Client main window, choose Instruments > Remote Instrument Explorer .
2. In the Remote Instrument Explorer dialog, click Query All Instrument ID's , as shown.

E Agilent Connection Manager Client

File Server Instruments Measurements ‘Window Help

h'TI Remote Inztrument Explorer - port 4790 -0 x l

Server ||'3"35|h'3'3t14?9':' Refresh Query Selected Instuments’ IDs | Query & Instruments' |D's ,J\ Help |

|

b

Y154 Resource |Instrumank 0 |
GPRIBO:14:INSTR  Agilent Techralogies, 8753E 0,714

GRIBO:1S:INSTR VI_ERROR_TMO: & timeout accumed

GRIBOMB:INSTR  Agilent Technologies ES3I584 LIS40210024.4 04 25

GRIBO:1E:INSTR  Agilent Technalagies E 44085 US41152605,4.04.21 20000921 10:42:11
GRIBO:1S:INSTR  Agilent Technalogies, ESG-D40008, MYy £1000133, B.02.75
GRIBO:7:INSTR  Agilent Technologies 548320 MMy 42000431 1.02 25 R.080

c:[Program Files| Agilent/Conneckion Manager ServerTOConfig.xml

3. In the Connection Manager Client main window, choose File > Save As .
4. For UNIX and Linux systems , browse to the ADS configuration directory (by default $HOVE/ hpeesof/ confi g/ ),

15
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enter the file name I0Config.iml (case sensitive), and click Save .

For PC systems_ , in the Save As dialog, use the Look in: drop-down box to navigate the to ADS configuration
directory (by default C: \ user s\ def aul t\ hpeesof\ confi g ), enter IOConfig.iml (case sensitive).
. In a text editor on the client workstation, open the I0Config.iml file, as shown. <MsmtClientConfig Version="1.0"
RemoteHost="localhost" Port="4790" ServerSelected="0">

<InstExplorer RemoteHost="localhost" Port="4790">

<IOConfigEntries>

<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />

<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />

<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />

<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />

<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent Technologies,
ESG-D4000B, MY41000133, B.03.75" />

<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,1.02.25 R,080" />

</10ConfigEntries>

</InstExplorer>

<Measurements />

</MsmtClientConfig>

. Add additional bolded sections, as shown, for every server you want to search for instruments.
<MsmtClientConfig Version="1.0" RemoteHost="localhost" Port="4790" ServerSelected="0">
<InstExplorer RemoteHost="localhost" Port="4790">

<IOConfigEntries>

<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />

<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />

<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />

<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />

<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent Technologies,
ESG-D4000B, MY41000133, B.03.75" />

<I0OConfigEntry VisaResource="GPIBO0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,1.02.25 R,080" />

</I0ConfigEntries>

</InstExplorer>

<InstExplorer RemoteHost="sanc070322977.soco.agilent.com" Port="4790">
<IOConfigEntries>

<IOConfigEntry VisaResource="GPIB1::16::INSTR" />

</I0ConfigEntries>

</InstExplorer>

<InstExplorer RemoteHost="123.456.789.10" Port="4790">

<IOConfigEntries>

<IOConfigEntry VisaResource="GPIB2::7::INSTR" InstrumentDescription="My Scope" />
</10ConfigEntries>
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</InstExplorer>
<Measurements />
</MsmtClientConfig>
For each server (in this example, sanc070322977. soco. agi | ent. comand 123. 456. 789. 10 ) connected to
instrument you wish to list, there is an InstExplorer attribute, contained in the <l nst Expl or er >
</ I nst Expl or er > tags.
The RemoteHost attribute describes the server to which the instruments are connected.
The IOConfigEntries tag surrounds the list of instruments you want to list for the associated server. Each
I0ConfigEntry entry lists the information for one instrument.
The VisaResource attribute is the string that will be used to identify the instrument to the IO Libraries.
The InstrumentDescription attribute populates the Instrument ID field in the Instrument Explorer. If you do not
include an InstrumentDescription attribute, the Instrument Explorer will display the string No correspondi ng
instrument description in IO configuration file inthe Instrument ID field.

7. Change the I nstrunent Descri pti on attributes to customize the instrument identification, as shown.
<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="NWA on my bench" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="NWA printer
pass-through" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent E8358A in the
lab" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="VSA on my bench" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="PSG on my bench" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Infiniium on my bench" />
</I0ConfigEntries>

8. To list network-connected instruments, create the following I0ConfigEntry, where TCPI PO is the configured
network IO, server 1. nyconpany is the DNS name of the remote server to which the hardware is connected, and
PSG i n Japan is the customized instrument identifier, as shown.

<IOConfigEntry VisaResource="TCPIPO::serverl.mycompany.com::INSTR" InstrumentDescription="PSG in
Japan" />

9. Save the IML file to the ADS configuration directory (by default $HOVE/ hpeesof / confi g/ ).
10. To display your customized instrument identifiers, in the Remote Instrument Explorer dialog, click Refresh >
Query All Instrument ID's , as shown.
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E Agilent Connection Manager Client

File Server Instruments Measurements Window Help

Remote Inztrument Explorer - port 4790 - O] x I
Server ||'3'3~3|h'2'3t14?9':| Befiesh | Buemny Selected Instruments’ D | Buery All Ingtruments' 1De ,\L Help I
|
VIS4 Rezource | Irestiument 10 | o
GFIBO:14:IMSTR MW on my bench
GFIBO:15:IMSTR MW printer pass-through
GPIBO:1E:INSTR Agilent E83584 in the lab
GPIBO:18:IM5TR WSA on my bench
GPIBO:12:IMSTR ESG on my bench
GRIBO: 7 IMNSTH Infiriiinn o iy bench
TCPIPQ: zerver] mpcompany.com PSG inJdapan

Server-Based 10 Configuration

Instead of the server querying the IO for connected instruments, the server displays the contents of a user-defined
XML file in the Remote Instrument Explorer dialog.

The VISA libraries do not have the capability to dynamically discover instruments through the TCPIP entry in the IO
Libraries I0 Configuration database. Using file-based instrument discovery allows the Remote Instrument Explorer
dialog to list network-connected instruments that would otherwise not appear.

B Note

When using file-based instrument discovery, no instrument communication takes place during the discovery
process.

This procedure modifies and then references the I0Config.xml file on the server PC for instrument discovery.

1. In the Connection Manager Client main window, choose Instruments > Remote Instrument Explorer .
2. In the Remote Instrument Explorer dialog, click Query All Instrument ID's , as shown.
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E Agilent Connection Manager Client

File Server Instruments Measurements ‘Window Help

Remote Instrument E xplorer - port 4730 - ol = l

Server ||'2"3-3|h'2'3t14?9|:| Refrash | Duesy Selected Instuments’ ID: | Queny &1l Instruments' |Dg ,\l\ Help |

1
Y154 Resource |Instrumant D | R
GPRIBO:14:INSTR  Agilent Techrnologies, 8753E 0,714
GRIBO:S:INSTR VI_ERROR_TMO: & timeout occuned
GRIBO:B:INSTR  Agilent Technologies ES3588 LIS40210024 .4 04 25
GPRIBO:1E:INSTR  Agilent Technalagies E 44084 US41152605,4 04 21 20000921 10:42:11
GRIBO:19:IMSTR  Agilent Technologies, ESG-D40008, MYy 41000133, B.03.75
GRIBO:7:INSTR  Aglent Technologies, 548320 MY 42000431 1.02.25 B.080

c:/Program Files]Agilent/Connection Manager ServerTOConfig.xml

3. In the Connection Manager Client main window, choose File > Save As .

4. For UNIX and Linux systems , enter the file name IOConfig.xml (case sensitive), note the directory to which the
file is being saved, and click Save .
Next, from the server PC transfer this file from the UNIX or Linux directory to the Connection Manager
installation directory on the server PC. This directory is C:\ Program Fi | es\ Agi | ent\ Connecti on Manager
Server by default.
For PC systems_ , in the _Save As dialog, use the Look in: drop-down box to navigate the to CM server
installation directory.
This directory is C:\Program Files\Agilent\Connection Manager Server\ by default.
In the Save As dialog File name: entry box, enter IOConfig.xml (case sensitive).
In the Save As dialog File type: drop-down box, choose Connection Manager Client Serialization Files (.xml)* and
click OK .

5. In a text editor on the server PC, open the IOConfig.xml file, as shown. <MsmtClientConfig Version="1.0"
RemoteHost="localhost" Port="4790" ServerSelected="0">
<InstExplorer RemoteHost="localhost" Port="4790">
<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent Technologies,
ESG-D4000B, MY41000133, B.03.75" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,1.02.25 R,080" />
</I10ConfigEntries>
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</InstExplorer>
<Measurements />
</MsmtClientConfig>

. Remove all but the <I OConfi gEnt ri es> section, as shown. <IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="Agilent
Technologies,8753E,0,7.14" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="VI_ERROR_TMO: A
timeout occurred" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent
Technologies,E8358A,US40210024,A.04.25" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="Agilent
Technologies,E4406A,US41152605,A.04.21 20000921 10:42:11" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="Agilent Technologies,
ESG-D4000B, MY41000133, B.03.75" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Agilent
Technologies,54832D,MY42000431,1.02.25 R,080" />
</I10ConfigEntries>

. Change the InstrumentDescription attributes to customize the instrument identification, as shown.
<IOConfigEntries>
<IOConfigEntry VisaResource="GPIB0::14::INSTR" InstrumentDescription="NWA on my bench" />
<IOConfigEntry VisaResource="GPIB0::15::INSTR" InstrumentDescription="NWA printer
pass-through" />
<IOConfigEntry VisaResource="GPIB0::16::INSTR" InstrumentDescription="Agilent E8358A in the
lab" />
<IOConfigEntry VisaResource="GPIB0::18::INSTR" InstrumentDescription="VSA on my bench" />
<IOConfigEntry VisaResource="GPIB0::19::INSTR" InstrumentDescription="PSG on my bench" />
<IOConfigEntry VisaResource="GPIB0::7::INSTR" InstrumentDescription="Infiniium on my bench" />
</I0ConfigEntries>

. To list network-connected instruments, create the following IOConfigEntry, where TCPI PO is the configured
network IO, server 1. nyconpany is the DNS name of the remote server to which the hardware is connected, and
ESG i n Japan is the customized instrument identifier, as shown.

<IOConfigEntry VisaResource="TCPIPO::serverl.mycompany.com::INSTR" InstrumentDescription="PSG in
Japan" />

. Save the XML file to the CM server installation directory (by default: C:\Program Files\Agilent\Connection
Manager Server\ ).

. To display your customized instrument identifiers, in the Remote Instrument Explorer dialog, click Refresh >
Query All Instrument ID's , as shown.
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E Agilent Connection Manager Client

File Server Instruments Measurements Window Help

Remote Inztrument Explorer - port 4790 - O] x I
Server ||'3'3~3|h'2'3t14?9':| Befiesh | Buemny Selected Instruments’ D | Buery All Ingtruments' 1De ,\L Help I
|
VIS4 Rezource | Irestiument 10 | o
GFIBO:14:IMSTR MW on my bench
GFIBO:15:IMSTR MW printer pass-through
GPIBO:1E:INSTR Agilent E83584 in the lab
GPIBO:18:IM5TR WSA on my bench
GPIBO:12:IMSTR ESG on my bench
GRIBO: 7 IMNSTH Infiriiinn o iy bench
TCPIPQ: zerver] mpcompany.com PSG inJdapan

Saving the Application State

Connection Manager tracks the current state of configuration and saves this information to an application state file. A
application state file contains the current client configuration. The status area of the client main window updates to

indicate whether the application state has changed and if an application state file has been associated with a given
session.

If a content change to the client window occurs before a state file is defined by a file save operation, an asterisk
appears in the status bar.
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= Agilent Connection Manager Client

File Server Instruments Measurements Window Help

*

_[:6

1. In the client dialog, click File > Save as ... .
2. Save the application to a file named statel .

After saving the session state, the status bar records the location of the state file.

E Agilent Connection Manager, Client E]@WE'

File Server Instruments Measurements ‘Window Help

:/owgwin/home/jhicks/hpeesaf fconfig)statel oml

N

Further changes to the client session append an asterisk to the state file name.
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E Agilent Connection Manager Client

File Server Instruments Measurements Window  Help

i foygwinthome/jhickshpeesof /config/stake 1 xml*

"

For more information, see File Menu.

Performing Connected Measurements

This chapter teaches you how to make connected measurements using the measurement panels accessible through
the Connection Manager client.

Overview

From the Connection Manager client dialog, you can access 2-port power swept S-parameter, S-parameter, spectrum,
and voltage waveform measurements.

Connection Manager uses measurement panels to configure instruments, execute measurements, and collect and
format ADS datasets. Using these dialogs, you can easily configure and perform measurements made available on the
server.

For detailed information on the measurement configuration, see Understanding the Measurement Panels.

Measuring S-Parameters

Connection Manger measurement panels enable behavioral modeling (2-port power swept) measurements and 2-, 3-,
and 4-port frequency swept S-parameter measurements using the following network analyzer families.
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2-port power swept measurements available for:

e 8753/8722/8720/8719 network analyzer family
e ENA B, ENA C, PNA, and PNA-X network analyzer families
2-, 3-, and 4-port frequency swept measurements available for:
e 8753/8722/8720/8719 network analyzer family
e 8712/8714 network analyzer family
e ENA B, ENA C, PNA, and PNA-X network analyzer families
e 8510 network analyzer family

B Note

In all cases, the instrument must return both amplitude and phase information. Scalar analyzers do not
provide information in a format suitable for use with Connection Manager.

To Measure 2-Port Power Swept S-Parameters

This measurement is available for two network analyzer families, the Agilent 8753/ 8722/8720/8719 Network Analyzer
Family and the Agilent ENA B, ENA C, PNA, and PNA-X Series Network Analyzer Families .
For detailed information regarding S-parameter measurement panel functionality, see Understanding S-Parameter and

Behavioral Modeling Measurements.

To make a 2-port power swept S-parameter measurement, complete the following steps.

1. Configure the frequency and power settings, and calibrate the network analyzer.
2. Insert the device under test into the measurement path.
3. Select Measurements > Behavioral Modeling > ENA B and PNA Network Analyzer Families .
4. To update the Select Instrument list with the latest instruments configured on the server, click Refresh .
5. Select the VISA resource connected to the network analyzer from the Select Instrument drop-down list.
6. In the Select Power Settings group box Start Power (dB) data entry field,
enter - 20 .
7. In the Stop Power (dB) data entry field, enter - 10 .
8. In the Step (dB) data entry field, enter 1 .
9. Deselect all measurements except S11 .

10. Enter devi cel_psS11 in the Dataset Name field.
11. To send the client information in the Power Swept Measurement panel to the server workstation, click Measure .
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E Agilent Connection Manager Client

File Server Instruments Measwements ‘Window Help

gpmr Swept S-Parameter Measurement - ENA B and PNA Network Analyzer Families - part 4790 !EH

Server [localhost
— Select Instrument
|GPIB216:INSTR =] Refresh I I~ Overide instrument model check
Select Power Settings
Start Posver[dB m) Stop Power[dBm] StepidB]
Power Sweep Settings
|-20 10 1

P2-P1 Power Offset(dB) |0

- Select Measurement
W 511 [ 512

™ sa1 [ s&2

i Export Data
[~ Export to Test File Fie Type | F2D MDIF " p2d) =]

File rame | Broasss

- Save Datazet

Measure

Dataset Mame |device1_psﬁ11 Browse...

Block Name ]EM Help

The server processes the request and returns the results. The first time a measurement is run, the server
imports the drivers and libraries necessary for the proper execution of the measurement. The results are stored
in the dataset file. These stored values can be used by Data Display and/or in a simulation.

B Note

While the measurement is running, the Measurement window is disabled. When finished, a Measurement
complete window appears. Select OK to dismiss.

To Measure 2-Port Frequency Swept S-Parameters
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To make a 2-port S-parameter measurement, complete the following steps.

Configure the frequency and power settings, and calibrate the network analyzer.

Insert the device under test into the measurement path.

Select Measurements > S-Parameters > ENA B and PNA Network Analyzer Families .

To update the Select Instrument list with the latest instruments configured on the server, click Refresh .

Select the VISA resource connected to the network analyzer from the Select Instrument drop-down list.
Deselect all measurements except S11 .

Enter devi cel_S11 in the Dataset Name field.

To send the client information in the S-Parameter Measurement panel to the server workstation, click Measure .

®NOUTAWN =

= Agilent Connection Manager Client El@|rz|
Fle Server [nstruments Measurements Window Help

== S-Parameter Measurement - ENA-B Network Analyzer Family - part 4790 B =1 E
Server Ilu-cahwt

Selact Instument

[ ;] Refiesh [~ Ovemide instrument model check

Select Measurement
W 511 [ 512 [ 513 [ 514

s S22 s3 osa _ooectAl

TSN CsI: O s:® O S
~odl oS4 o3 [ osas . oeeA

Export Data

[ Ewport to Test File File Type | CitiFile -'I
File name | Browse |

Save Dataset

M easure |
Dataset Name | Browse...
Block Mame  |Ci Help |

W

]

The server processes the request and returns the results. The first time a measurement is run, the server
imports the drivers and libraries necessary for the proper execution of the measurement. The results are stored
in the dataset file. These stored values can be used by Data Display and/or in a simulation.

B Note

While the measurement is running, the Measurement window is disabled. When finished, a Measurement
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complete window appears. Select OK to dismiss.

For more information, see Understanding S-Parameter and Behavioral Modeling Measurements.

To Display the Measurement Data

To view the measurement data in a Data Display window, complete the following steps.

1. From the toolbar in the schematic window select Window > New Data Display .

2. Select the devicel_S11 dataset.

3. Select the Rectangular Plot button, then select inside the Data Display window to open the Plot Traces &
Attributes dialog box.

2% Data Display/Untitled 1* [page 1]:1
File Edit %iew Insert Marker Page Options Tools Help

Selal sl 0] 5]
devicel S11 ‘J‘ ‘JlJlJl

E I

> 0| 5|68 @ |+
O/ |E D B

B Note
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The measurement variable is s1_1 . If only part of an S-parameter matrix is stored, the variable names cannot
use the standard matrix notation. If all four S-parameters are selected, and Measure is selected again, the
dataset variable naming conforms to the matrix notation.

22 Data DisplayfUntitled 1* [page 1]:1
File Edit Wiew Insert Marker Page Options Tools Help

_.Ilﬁbl |§] | :_ _r_.._l %l _l B Plot Traces & Attributes: 1

Flot Type | Plat Options I

= @ B B B |-

Datazets and Egquations Traces

devicel 511

freag dB(z1_1]
511

B8 @ |+
O/ |E B B

Eqn

Advanced.., |

[T Show Hierarchy

T kanage Datazets. . |
QK. [\l Cancel | Help |
-5 -
< >

The following illustration shows the result of an S11 measurement displayed in the Data Display window.
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2 Data Display/Untitled 1* [page 1]:1
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To Export the Measurement Data to a Text File

Besides storing measured S-parameter data in a dataset, you can also export it to a text file in either CitiFile or
Touchstone formats.
To export the S-Parameter measurement data to a text file, follow these steps.

Select the Export to Text File check box.

Select the file type to export from the File Type drop-down list.

Click Browse to select an existing file, or type the file name for a new file.
To record the data into the selected text file and dataset, click Measure .

PN
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=] Agilent Connection Manager Client

File Server Instruments Measuremenks ‘Window Help
H-TI S-Parameter Measurement - ESEC4/E 8 ROLMN IEL Hetwork Analyzer Family - port 4790

Server II::u:th-:ust:4?ElD

Select Instrurnent
|GPIED::1E::INSTH j Refresh I [T Ovemde instument model check

Select Meazurement

s T s12 [ 513
s [T sz2 [ s

Ms3 sz [ s:. M

Export Data
W Export to Text File File Type | CitiFile -
File name |I::.-’l:ygwina’h-:umefihicks!EM_VSA_FﬂJHdata!deviﬁeLﬂ1.||::ii Browse. |

Save Datazet

i M [ !
Datazet Mame | devicel 511 Browse. Eazune

Block Name | CM Help |

*

For more information on exporting S-parameter data, see Understanding S-Parameter and Behavioral Modelin
Measurements.

Measuring Frequency Spectrum

Use the Spectrum measurement panel to gather frequency domain measurement data. Spectrum measurements are
available for three types of spectrum analyzers:

e 856XX spectrum analyzer family
e 859XX spectrum analyzer family
e E444XA PSA Series spectrum analyzers
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To Measure Frequency Spectrum

For detailed information regarding frequency spectrum measurement panel functionality, see Understanding Spectrum
Measurements.

To make a frequency spectrum measurement of a carrier at 2 GHz —10 dBm using an E444XA PSA, complete the
following steps.

Preset the spectrum analyzer.

Connect the spectrum analyzer INPUT to the signal source.

On the PSA, set Trace 1 to Max Hold and Trace 3 to Min Hold.

Select Measurements > Spectrum > E444X Spectrum Analyzer Family .

To update the Select Instrument list with the latest instruments configured on the server, click Refresh .
Select the VISA resource connected to the spectrum analyzer from the Select Instrument drop-down list.
In the Select Frequency Settings group box, choose the Start/Stop Frequency radio button.

In the Start Freq field and Units drop-down list, enter 1. 998 and choose GHz .

In the Stop Freq field and Units drop-down list, enter 2. 002 and choose GHz .

In the Select Measurement group box, select the Trace 1 and Trace 3 check boxes.

. To send the client information in the Spectrum Measurement panel to the server workstation, click Measure .

WoNOUhWNE

=
= O
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=] Agilent Connection Manager Client
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Select Instrument
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The server processes the request and returns the results. The first time a measurement is run, the server
imports the drivers and libraries necessary for the proper execution of the measurement. The results are stored
in the dataset file. These stored values can be used by Data Display and/or in a simulation.

Li]

Note

While the measurement is running, the Measurement window is disabled. When finished, a Measurement
complete window appears. Select OK to dismiss.

Note

While the measurement is running, the Measurement window is disabled. Upon completion a Measurement
complete window appears. Select OK to dismiss this window.

The following screen capture shows the results of the preceding measurement.
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For more spectrum measurement information, see Understanding Spectrum Measurements.

Measuring Voltage Waveform

Use a Voltage Waveform Measurement panel to gather time domain measurement data. Voltage waveform
measurements create datasets where the Y-axis values represent sampled voltage data and the X-axis values
represent the times at which each voltage sample was taken.

Voltage waveform measurements are available for the following oscilloscopes:

e Agilent 86100A oscilloscope
e Agilent 5462X and 5464X oscilloscope families
e Agilent 5483X and 5485X oscilloscope families (with client-based instrument configuration)

When using the first three measurement panels, the client measurement panel configures only data storage. You must
manually configure channel, timebase, trigger, and memory settings on the oscilloscope front panel before executing
the measurement.
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Using the Agilent 5483X and 5485X Oscilloscope Families measurement panel, you can configure many oscilloscope
settings and download the settings to the oscilloscope from the client.

A cooperative protocol exists between clients and the server to prevent buffer overrun caused by transferring
waveforms with too many data points, allowing the transfer of waveforms containing as many data points as the
oscilloscope can store.

The 5483x and 5485x oscilloscope measurement checks to see that the corresponding server library is at the correct
revision to support buffered transfers.

! Caution
Use caution when transferring large waveforms, as doing so results in extremely large data set files.

To Measure Voltage Waveform

The following example uses the Agilent 54832B Infiniium oscilloscope to make a voltage waveform measurement. This
measurement includes instrument configuration from the client measurement panel.

For detailed information regarding voltage waveform measurement panel functionality, see Understanding Voltage
Waveform Measurements.

To configure the instrument and perform the measurement, complete the following steps.

Connect the oscilloscope channel 1 INPUT to the signal source.

From the client, select Measurements > Voltage Waveform > 5485X and 5483X Oscilloscope Families .

To update the Select Instrument list with the latest instruments configured on the server, click Refresh .
Select the VISA resource connected to the oscilloscope from the Select Instrument drop-down list.

In the Data Storage tab, select the Channel 1, Memory 1, Channel 2 , and Memory 2 check boxes. In the
Dataset Name entry field, enter Vol t ageWavef ornt .

nhwn e

34


http://edocs.soco.agilent.com/display/ads2008/Operational+and+Functional+Concepts#OperationalandFunctionalConcepts-1126974
http://edocs.soco.agilent.com/display/ads2008/Operational+and+Functional+Concepts#OperationalandFunctionalConcepts-1126974

Advanced Design System 2008

=] Agilent Connection Manager Client

File Server Instruments Measurements ‘Window Help

4 Yoltage Waveform Measurement - Agilent 5483xA/and 5485x Oscilloscope Families [l I=] B I

Server Ilucalhnst - 4780

Select Instument |GRIBD:7:INSTR| »|  Refresh |

Data Storage ]Ehannsl Settings ] Timebase Seftings |Trigga53ttilgs |Mmy‘5$tt-ings Advanced

— Select Waveform(s)
¥ Charrell W Channel2 [ Channel3 [ Channel 4 Select Al
v Memaory1 W Mamn%i‘ [ Memary 3 [ Memoy 4 Clear All |
— Save Datagat
Datazet N arme [UnltagaWavufnrm‘i Browse...
Dawrload ‘W avefarm(z) Apply Settings Anply then Download Done Help

*

6. In the Channel Settings tab, choose the Channel 1 tab and enter 2 V for the Scale, select the Display channel 1

and the Include panel contents in instrument upload check box. Choose the Channel 2 tab and select the Display
channel 2 and the Include panel contents in instrument upload check box.
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=] Agilent Connection Manager Client
File Server Instruments Measuremenkts ‘Window Help

4 Yoltage Waveform Measurement - Agilent 5483xB and 5485x Oscilloscope Families [l I=} B I

Server II::u:thu:ust: 4790

Select Instument |GPIBO:7:INSTR »|  Refiesh |

Data Storage | Charnel Settings lTimbawSeﬂhgs |Trigga53ﬂ'ngs |Hmyﬁett-ings Advanced

Channel1 | Channel2 | Channel3 | Channel4 |

¥ Include panel contents in instrument upload

Iv Dizplay channel 2
Seale [Valts / divisinn%

I v =
Oiffget

o EU

Diownload W aveform(z) Apply Sethngs Apply then Dovanload Done Help

#®

7. In the Timebase Settings tab, choose Left from the Timebase Reference drop-down list and select the Include
panel contents in instrument upload check box. In the Timebase Scale entry fields, enter 20 ns .
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=] Agilent Connection Manager Client

File Server Instruments Measurements ‘Window Help

4 Voltage Waveform Measurement - Agilent 5483xB/and 5485x Oscilloscope Families [l I=] B I

Server Ilucalhnst - 4790

Select Instument |GPIB0:7:INSTR «|  Refresh |

Data Storage ] Channel Settings | Timebase Setfings ITriggﬁSBlthgs |Hmw‘5&ttings &dvanced

¥ Include parel contents in instument uplaad

Timebase reference

Timebase scale [Seconds / division) [20 [ ns j
Timebase delay 0 lps =)

Drawrload ‘W aveformm(z) Apply Sethings Apply then Download Done Help

8. In the Trigger Settings tab, choose Channel 2 from the Trigger source drop-down list and select the Include
panel contents in instrument upload check box.
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=] Agilent Connection Manager Client

File Server Instruments Measurements Window Help
4 Yoltage Waveform Measurement - Agilent 5483xB and 5485x Oscilloscope Families [ [ufl B
Server [locahost ; 4730
Select Instrument |GPIBO:7:INSTR v|  Refiesh |
Data Storage ] Channel Settings ] Timebase Settings | Trgoer Sellings | Memory Settings | Advanced
¥ Include panel contents in instrument upload
~ Trigger Settings
Trigger mode | Auto |
Trigger source
Trigger slope [ Positive [rizsing edge) -
Trigger holdaff |80 Ins =]
Trigger hysterazis [Hnrmal ﬂ
~Trigger Levels
External |0 [mv =]
Charinel 1 |0 [mv =]
Charinel 2 |0 |mv =]
Charinel 3 |0 [mv =]
Charinel 4 |0 [mv =]
Download YW aveform(z)] Apply Settings | Apply then Download [Done Help
"

9. In the Memory Settings tab, choose the Memory 1 tab and select the Include panel contents in instrument upload
, and Display memory 1 check boxes. Choose the Memory 2 tab and select the Include panel contents in
instrument upload , and Display memory 2 check boxes.
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=] Agilent Connection Manager Client

File Server Instruments Measurements ‘Window Help

4 Voltage Waveform Measurement - Agilent 54838 and 5485x Oscilloscope Families Sl =l B I

Server II::u:thu:ust: 47490

SelectlnstrumentIGF‘IBEI::?::INSTFI LI Refrezh |

Data Storage | Channel 5ettings | Timebase Settings | Trigger Settings Mermory Settings Iﬁ.duan:sd

M ey 1

¥ Include panel contents in instrument upload

v Display memany h

# Range I'IDIJ " | me |

¥ Offset |0 [ps |

Y Range |200 [ v -]

Y Offset |0 i -]

D owrload W avefarm(z) Apply Settings Apply then Download Done Help

*

10. In the Advanced tab, select the Override instrument model check check box.

i)

Note
Selecting the Override instrument model check check box is necessary only when using an unsupported

oscilloscope. Other oscilloscopes will most likely use the same instruction sets as the Agilent 54832X or
54855X.
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E Agilent Conpection Manager Client

File Server Instruments Measurements Window Help

=4 Voltage Waveform Measurement - Agilent 5483xB and 5485x Oscilloscope Families

Server IIl:u:thI:ust ;47490

Select Instument |GFIBD:7:INSTR »|  Refiesh |

Data Storage ] Channel Settings ] Timebase Seltings |Trigpaﬁﬂtthg$ |Mancw‘3e:ttings | Advanced |

¥ | Dveriide instument model check
[~ Perform autoscale before acquiing trace data
Tire to wait to acquire exclusive instiumant lock [seconds) [2—
Tirne bo wait far wavefarm transier [seconds) [10—
Save Instrument State... | Recall Instrument State... |
Raset Instument | Clear Instrument Status |
Dowrload Wavebors) Apply Settings Apphy then Dowrload Done Help

11. Click Apply then Download .
The following screen capture shows the results of the preceding measurement using the Data Display server.
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For more spectrum measurement information, see Understanding Voltage Waveform Measurements.

Troubleshooting Connection Manager

This chapter offers solutions to common installation, configuration, and instrument communication problems, as well
as instruction on using the server diagnostics tool.

Server Installation and Configuration

This section lists common Connection Manager server installation and configuration problems and their possible
solutions.

Server 10 Fails Running Under the LocalSystem Account

When running the Connection Manager as a Windows service (see Running the Server as a Windows Service) and
trying to connect to the CM ESG E4438C Sink (or other CM component), the following error message (or a message
announcing the VISA32.dll did not load) is displayed.
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MsmtSryr.exe - Application Ervor . ' ﬂl

@ The instruction ak “0x041020f4" referenced memory at “D00000000°, The memory could not be “read”,

Click on QK ko berminake the program
Click on CANCEL to debug the program

Solution: use a named account.

Run the Connection Manager Server under an account with Administrator privileges.
The problem is a conflict involving the SICL interface and Connection Manager interface on certain PCs. In some cases,
Connection Manager cannot be run as a LocalSystem account service.

To check if Connection Manager is running under a LocalSystem Account:

From the Windows toolbar, click Start > Settings > Control Panel.

2. In the Control Panel dialog, click Administrative Tools.

v

In the Administrative Tools dialog, click Services. (If you do not have access to the Services icon from the
Administrative Tools dialog, see following section.)

In the Services dialog, right-click on the Agilent Connection Manager and select Properties.

In the Properties dialog, select the Log On tab.

Observe the Log on as: setting.

If your PC is set to LocalSystem account, follow the instructions in Configuring User Account Privileges on the PC.

If you do not have access to the Services icon from the Administrative Tools dialog

Some PCs may not have the Services shortcut available in the Administrative Tools dialog. If so, follow these steps.

A WN

In Windows Explorer, navigate to %SystemRoot%\system32 to find the services.msc (Microsoft Common
Console Document). For example, C:\WINNT\system32\services.msc.

Double-click on the services.msc file to bring up the Services dialog.

In the Services dialog, right-click on the Agilent Connection Manager and select Properties.

In the Properties dialog, select the Log On tab.

Observe the Log on as: setting.

If your PC is set to LocalSystem account, follow the instructions in Configuring User Account Privileges on the PC.
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No Connection and "Connection Refused" Error Messages

Solution: for systems with firewalls, specify the server port number to allow access.

Firewall software, like Norton Internet Security, Zone Alarm, or the Windows XP Personal Firewall application, can
interfere with the server's ability to communicate on a network. This will manifest itself as the client application
receiving a Connection Refused message when trying to run a measurement.

Most of these applications allow you to configure the server to allow certain applications to access the network. For
firewall software applications that require the port number for the CM server, see the C:\Program
Files\Agilent\Connection Manager Server\MsmtSrvr.exe.config file for the configured port number the server uses to
communicate with clients.

The server uses transient ports, which allow for faster data transfer. The ports are allocated dynamically, starting with
port number 5001,extending to 10,000.

Solution: determine if another process is binding the port and reconfigure.

The server allows network communication from clients by listening to a port identified in the MsmtSrvr.exe.config file.
If the server cannot bind the port, possibly because another application is using that port, the client will get "
connection refused " messages.

In addition, the server machine will run slowly. The server will try to restart itself in the event that it exits abnormally.
Failure to bind to the port in the MsmtSrvr.exe.config file will cause an abnormal exit. Continued failure to bind the
port will cause the server to continually try to restart, resulting in a slow server PC.

You can determine if there is a port conflict by running the command " netstat -a " from a command prompt on the
server PC.

If the client receives a message that the connection has been refused and the server becomes very slow, it is probable
that the server port is being used by another process.

To verify this problem, complete the following steps:

1. From the Windows tool bar, select Start > Settings > Control Panel > Administrative Tools > Services __ to open
the Services window.

2. Highlight Agilent Connection Manager.

3. Select Action > Stop to stop the Connection Manager service.

4. Open a Command Prompt window and type:
netstat -a

5. Press Enter.

This provides a list of active connections on the server workstation. If the port number used by Connection Manager is
present in the Active Connections list, another process is using the Connection Manager port.

If this is the case, you must either stop this process to free the port or select a new port for use by Connection
Manager. To change the server's port number, refer to The MsmtSrvr.exe Process.
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To solve this problem, stop the server using the Windows Services control panel applet, change the server's port entry
in the MsmtSrvr.exe.config file, and restart the server.

Since the clients and server must agree on this port number, change the client parameters to use the port value you
just put into the MsmtSrvr.exe.config file.

B Note

The Process Explorer tool available from SyslInternals, http://www.sysinternals.com/, can help to determine if
the cause of refused connections is due to abnormal server termination. If you see the server process
(MsmtSrvr.exe) highlighted in red, it (the server) is continuously re-spawning.

Measurements Using Plug and Play Drivers Fail

Solution: install the required the required driver(s).

Several measurements depend on having Plug and Play drivers installed on the server PC. If a required driver is not
available, the client displays an error dialog, as shown.

E Agilent Connection Manager Client

System.Reflection. TargetInvocationException: Exception has been thrown by the target of an invocation. ---> System. DlINotFoundExceptic
at Agilent. TMFramework, InstrumentDriver Inkerop, Wxipnpitrappers, 405 75:x, ag875x_init(String instrDesc, Boolean idQuery, Boolean doRe:
at Agilent. TMFramework. InstrumentDriver Interop, YVeipnpWrappers. AgE75x, .ctor{String resourceMame, Boolean idQuery, Boolean reset)
at Agilent MeasurementServer, Sparmiismt. Aglent87S3SparmServer. .ctor{String visaResource, Boolean gueryldOnlnit, Boolean resetInst
--- End of inner exception stack trace -—
at Swstem., Reflection, RuntimeConstroctorInfo, InternallnvokelBindingFlags invokedttr, Binder binder, Object[] parameters, CulbureInfo cu
at Syskem.Reflection.RuntimeConstructorInfo, Invoke(BindingFlags imvokedttr, Binder binder, Object] parameters, CultureInfa culture)
at System.RuntimeType, Createlnstancelmpl(BindingFlags bindingattr, Binder binder, Object[] args, Culturelnfo culture, Cbject[] activatio
ak System. Activator.Createlnstance({Type type, BindingFlags bindingdttr, Binder binder, Object[] args, Culturelnfo culture, Object{] activ
at Agilent . MeasurementServer, ServerSocket, InstantiateTvpel)

To correct this, you must install the driver on the server PC. Drivers are available at the Drivers and Downloads link at
the Agilent Developer Network web site:
[www.agilent.com/find/adn]

Solution: install the Agilent IO libraries with Agilent VISA set to Primary.

Some of the Connection Manager measurements achieve instrument control by using Plug and Play drivers. Those
drivers depend on an Application Programming Interface known as VISA to communicate with instruments. There are
two major vendors supplying VISA implementations. Those implementations are not necessarily compatible, so, when
installing the Agilent IO Libraries, you may be presented with the need to choose between installing Agilent VISA as
either Primary or Secondary. Always install the Agilent VISA Libraries as Primary. For a complete description of this
topic, refer to the Agilent IO Libraries and NI Software document found at:

http://www.agilent.com/find/iolib.
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You can determine if your IO libraries have VISA installed and if VISA is installed as Primary by selecting the About
Agilent 10 Libraries Control entry from context menu in the IO libraries icon in the task bar.

To install the IO libraries with VISA as primary, run the IO libraries installation on the PC server, select the custom
installation button, then select the option that does a full installation with VISA as primary.

Part of the process of installing a Plug and Play driver causes the driver to record where it finds its VISA library. If you
upgrade or otherwise replace the IO Libraries installation and change the installation from primary to secondary ( or
vice versa), the Plug and Play driver may not be able to find its VISA implementation. This results in a measurement
displaying an error dialog indicating that the T&M Toolkit's driver interoperation layer encountered a failure trying to
call the driver's Init function.

The solution is to uninstall the IO libraries and reinstall with VISA as primary. Then uninstall and reinstall the Plug and
Play driver. Drivers are available at the Drivers and Downloads link at the Agilent Developer Network web site:
[www.agilent.com/find/adn]

For support installing and configuring the Agilent IO Libraries and for answers to your hardware or measurement
questions, contact your local Agilent Instrument Support Center at the number found on the following website:
[www.agilent.com/find/support]

Server Unregisters After Installing 2003C then Uninstalling 2003A

Solution: restart the measurement server from the control panel applet.

Part of the uninstalling process unregisters the Connection Manager Server - a Windows service. Since this is a system
component, only one instance may be actively registered on a system. When installing the server, the system registry
gets updated to use the server in whichever version of ADS is being installed. Likewise, uninstalling deletes the
registry entries related to the server.

If you install 2003A, then install 2003C, the registry uses the 2003C server. If you subsequently remove 2003A, the
server registry entries will be removed, and the server will no longer be configured.

To configure the server, open a command window on the server workstation and perform the following procedure:

From the <ADS Installation Directory Path>/bin directory, enter Msnt Srvc -install .

Open the Services control panel applet and select the Agilent Connection Manager entry's properties.
Select the login account you wish the server use.

Select the server startup option.

Start the service running by choosing Start from the control panel applet.

uhkwN e

Missing Blue IO icon in System Icon Tray

Solution: uninstall ADS 2003C server and install ADS 2004A server.

The blue IO icon must be active in the Windows system icon tray for the Connection Manager server to run.
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The IO Libraries installation places a shortcut to the IO Libraries application called iprocsvr in the system program
startup group. Iprocsvr is the entity responsible for putting the IO icon in the system icon tray. If iprocsvr is not
running on the server PC, instrument IO will not function.

The IO Libraries will not operate when there is no interactive logon session running on the CM server workstation. This
prevents the CM server from performing instrument 10 unless a user is interactively logged onto the server PC.

ADS 2003C and Earlier Running Server as Windows Service

As a work around, the ADS 2003C CM Server installation removed the iprocsvr shortcut. At startup, the ADS 2003C
server would check to see if iprocsvr was running. If not, the ADS 2003C server would start iprocsvr.

Running the 2003C server uninstall will restore the iprocsvr shortcut to the system program startup group.

ADS 2004A Running Server as Windows Application

To integrate better with the IO Libraries, the 2004A CM server runs as a Windows application. The 2004A server
installation unconfigures any previous server, effectively replacing the Windows service with a Windows application.
This is necessary, because two servers cannot run and listen to the same network port simultaneously.

If you install the 2004A server without first running the 2003C server uninstall, the iprocsvr shortcut may not be in
the system program startup group.There will be no IO icon in the system tray and any attempt to perform instrument
10 will fail.

To prevent this, run setup.exe from the /CM_Server directory of disk 2 in the 2003C media kit and select the option to
uninstall.

Alternatively, you could create a shortcut to the iprocsvr.exe program in the system program startup group.

Solution: enable process listing.

In ADS 2003C, the CM server process ( MsmtSrvr.exe ) would try to start the IO Libraries' I0 Control application (
iprocsvr.exe - the program responsible for putting the blue IO icon in the icon tray) if that application was not already
running.

To know whether it is necessary to start the IO Control application, the CM Server program would list the processes
currently running on the server PC. Some Windows installations disable the ability to perform this process listing, so
the CM Server could not run.

This results in the CM client not connecting, even after having changed the Windows service to run under an account
other than LocalSystem. Also, the Diagnostics application would not create an output file.

To verify that the problem is related to the server PC having disabled the ability to list processes, follow these steps.

1. In Windows, click Start > Settings > Control Panel.
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2. From the Control Panel dialog, click Administrative Tools > Event Viewer.
3. Scroll down to find error entries titled AgilentConnectionManager.
4. Right-click on the error entry and select Properties.
5. In the Description field, observe the following description.

Bvent Type: Error

Bvent Source: Agi | ent Connect i onManager

Bvent Category: None

Bvent ID: 4

Dat e: 6/ 15/ 2004

Ti ne: 12:24:54 PM

User : N A

Gonput er: SANC040320844

Descri ption:

The followi ng information is part of the event: Caught exception: System |nvalidQperationException:
RFrocess performance counter is disabled, so the requested operation cannot be perforned.

Syst em Di agnosti cs. Nt ProcessManager . Get Processl nf os\ (Perf ormanceCounterLib library\)

Syst em Di agnosti cs. Nt ProcessManager. Get Processl nfos\ (String machi neNane, Bool ean i sRenpt eMachi ne\)
Syst em Di agnosti cs. ProcessManager . Get Processl nf os\ (Stri ng machi neNane\)

Syst em Di agnosti cs. Process. Get ProcessesByNane\ (String processNane, String nmachi neNane\)

Syst em Di agnosti cs. Process. Get ProcessesByNane\ (String processNane\)

Agi | ent . Measur enent Server. Msnt Srvr. St art Si cl Daenons\ ( Bool ean& weSt art edSicl, Process& iproc\)

Agi | ent . Measur enent Server. Msnt Srvr. Main\ (String\[\] args\).

Q) ) ) ) Q)
— —+ —+ —+ — +

This verifies that the process performance counter has been disable, in turn disabling Connection Manager.

To enable the process performance counter (and thereby Connection Manager), from an account with Administrator
privileges, complete the following steps.

Open a command prompt and cd to the ADS installation's bin directory, for example, cd c:\ads2003c\bin

Stop the CM service by executing the command Msnt Srvc -stop .

Open the Registry Editor by entering regedi t .

Open the registry key HKEY_LOCAL_MACHINE\SYSTEM\ CurrentControlSet\Services\PerfProc\Performance.

If that registry key contains a value named Disable Performance Counters, set its value to 0 , as shown below.

uhwNE
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6. Restart the CM Service by executing the command Msnt Srvc -start.

No Instrument Access when Using Agilent 89600 Software

Solution: unconfigure the instrument using the Agilent 89600 Select Hardware dialog.

Agilent 89600 software claims total ownership of instruments for the length of time those instruments are configured.
If Connection Manager generates and error when trying to communicate with an instrument that has been used with
the Agilent 89600 software, unconfigure the instrument using the Agilent 89600 Select Hardware dialog.

To unconfigure the instruments, follow these steps.

1. Open the 89600 software.
2. From the Main dialog, choose Utilities > Hardware.
3. Using the instrument tabs, uncheck instruments you want to use with Connection Manager.

Instrument Interface and Communication
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This section list common instrument interface and communication problems and their possible solutions.

The Server Hangs During Measurements or Remote Instrument Explorer is not Responding

Solution: observe the instrument display, correct any error state, and clear any instrument errors.

Many older instruments may generate error messages and shut down their IO when they encounter an invalid state
setting or command. This will disrupt instrument communication until the error state has been corrected and the error
message has been cleared from the queue. Correct any invalid settings, ensure the instrument is receiving the correct
commands, clear the error queue, and repeat the measurement.

Solution: connect and power on all instruments listed in the 10 configuration.

If you have configured a LAN-connected instrument, but the instrument is not connected or not powered on, the IO
Libraries will try to open every listed device. Since the default time out value for opening a LAN instrument is 2
minutes, any absent LAN-connected instrument could cause the IO Libraries to take a long time to open an instrument
session. If an instrument listed in the server workstation IO configuration is not accessible (i.e., disconnected or
turned off), the client's Remote Instrument Explorer will become unresponsive.

To run the IO Config setup

To check for an unresponsive instrument, follow these steps.

In the server's Windows system tray, select IO > Run IO Config.

In the I0 Config dialog, highlight the TCPI P | an entry in the Configured Interfaces group box and select Edit.

In the LAN Client dialog, select Edit VISA Config.

The TCPIP dialog lists which instruments are connected to the server through the LAN.

Ensure that the instruments are connected and functioning properly.

If an instrument is not functioning, you must either return it to a functional state or remove it from the 10 config
and restart the Connection Manager service.

oA LNE

Run VISA Assistant to Verify Communication Link

To verify the server recognized your GPIB instrument, follow these steps.
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1. In the server's Windows system tray, select IO > Run VISA Assistant.
2. Observe your instrument displayed in the VISA Assistant display panel.

3. Close VISA Assistant.

Communication Problems with Older Instruments

Solution: send commands through the LAN server to slow the rate.

Late model computers can send instructions faster than many vintage instruments can process them. This situation
often manifests itself when the instrument returns a message that is not consistent with the measurement being

made.
It is possible to slow down communications with an older instrument by running the interface through the IO Libraries

LAN server, causing the instructions to be sent to the instrument at a slightly slower rate.
To send commands through the IO server, complete the following steps.

1. Run siclland.exe , located in the IO Libraries installation bin directory (i.e., \ Program Files \ Agilent \ IO Libraries
\ bin ) on the server workstation.

s Sepuer enabled For SICL-LAN and U:‘“—I protoco ls .

2. Run IO Config and add a VISA LAN client entry.
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Agilent IXX Libraries Configuration - IO Config

File ©Options Help

|0 Canfig configures and editz Agilent [0 interfaces.

- To configure a new interface, select the interface in ‘Available Interface Types' and click 'Taonfigure’
- To edit a configured interface, select the interface in ‘Configured Interfaces’ and click 'Edit’

- To automatically configure the interfaces identified with ™', click ‘Auto Config!

Available Interface Types Configured Interfaces

W54 Type  Interface Description WISA Mame  SICL Mame

ASHL *R5-232 COM Ports A GPIBQ gpib0 * &uka Config |
ASRL V154 LAN Cliert [e.g E55 GPIET gpib

GPIE *82350 PCI GPIB Card heet -

GPIE “GPIB Using NI-488.2 He oK |
GFIB 82341 154 GPIB Card

GFIB 82357 USE to GPIB

VIS4 LAN Client [e.g. ES8 Help |

GFIB A * GPIB A Cormmand bodu

TCFIP “Lask Clignt [LAM [netrume
JSE *USE Instruments

JSE WISA LAN Client for USE

R *E8497 IEEE-12394 to Wil
n'a LAM Server [PC as Server ¥

*MOTE: Auto Config will configure interfaces identified with an ™

3. Select Configure and specify the IP address of the server workstation (i.e., the workstation running IO Config ).

VISA LAN Client Interface {LAN to GPIB) X

Euestions? Prezss the Help button below. Recommended default walues are shown.

Local Settings
VISA Interface Name: |GPIB2 #

Cancel

LAM Clisnt SICL Interface Name: [lan :I
~ Remate Settings Help

The remate SICL intatfface must be 2 GPIB mteiface.
Defaults

3l

bl S N

Remate SICL Interface Mame: |mﬂ]

4. When you use the Connection Manager client to specify an instrument, select the instruments shown on the LAN
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interface ( GPIB1 in the preceding example).

Solution: Extend the length of the GPIB cabling between the server and the instrument.

Extending the length of GPIB cable between the server and the instrument can decrease the speed at which the instrument receives data

from the server.

Connection Manager Server Diagnostics

The Connection Manager client and server dialogs include server diagnostics. The Connection Manager Server
Diagnostics and Diagnostics Display dialogs collect and display server configuration information for use in
troubleshooting instrument communication problems.

B Note
At no time does the server implementation of this capability interact directly with instruments. Doing so could

interrupt a measurement in progress.
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Client Dialog

== Connection Manager Server Diagnostics - port 4790

Server IIDcthnst:4?E|D

Current directony: & \pragram files\agilent\connection manager server
Could rat read service registiy key, Spstern emor recorded: The operation completed suzcessfully,

10 Libraries set up comectly
10 Libraties version: M.01.01.04, |nstallation directany: E:\Program Fileshbgilenth0 Libraries
Agilent Yiza iz primarny: True

< |

ok Refrezh | Save tofile... | Help |

Server Dialog

= Diagnostic Display

":urrent directony: e:hprogram fileshagilentconnechion manager server
Could nat read service registry key, Sustem enor recorded The specified module could not be faund.

|0 Librarnes set up comrmecty
|0 Libraries wersion: b.07.01.04, Installation drectony: E-\Program Files\&glent\|0 Libranies

Agilent Viza iz primany: True

<

?

(] 4 Save... |

As shown, the client dialog contains a Server entry field, an information display area, as well as OK , Refresh , Save to
file... , and Help buttons. The server dialog contains a an information display area, as well as OK and Save... buttons.

The Server field displays the name of the currently configured server.

The display area will contain the information gathered by the diagnostics routine. For individual explanations, see

Understanding the Server Diagnostics Output.

Choose OK to dismiss the dialog.

Choose Refresh to refresh the diagnostic information after making changes to your server configuration.
Choose Save to file... or Save... to open a Save File dialog where you can save the diagnostic dialog contents in a text
file. E-mail this text file to Agilent EEsof support staff to provide them with the information to diagnose an instrument

10 problem.

To Diagnose the Server From the Server Window
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From the Connection Manager Server main window, choose Diagnostics > Run Diagnostics.
Observe the information in the display area.

Make necessary corrections to the server configuration.

Close the server.

Reopen the server.

Choose Diagnostics > Run Diagnostics.

Observe the information in the display area.

To save the diagnostics information, click Save to file... and enter a file name and directory path.
To exit diagnostics, click OK.

RN A WN =

To Diagnose the Server From the Client Window

From the Connection Manager Client main window, choose Help > Diagnostics.

Choose server using the Set Server dialog and click OK.

Observe the information in the display area.

Make necessary corrections to the server configuration.

Click Refresh to run the diagnostics again.

To save the diagnostics information, click Save to file... and enter a file name and directory path.
To exit diagnostics, click OK.

Nouhwhe

Understanding the Server Diagnostics Output

This section describes the individual server diagnostics output items, from top to bottom of the display.

The CM Service Information

This section contains server version, server installation path, and the operating state of the server, as shown:

CM Service version info: 3.0.2004.1, Installation path: C\Program Fil es\Agilent\Connection Manager
Server\ Msnt Srvc. exe, Service state: The service is running.

Server version 2.0.2003.3 is ADS 2003C, server version 3.0.2004.1 is ADS 2004A, server version 4.0.2005.1 is ADS
2005A, ADS 2006A is 5.0.2006.1.

The installation path is read from the registry key HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Services\AgilentConnectionManager\ImagePath. The installation package creates this
registry key when you install the Connection Manager server.

The diagnostic routine queries the Service Control Manager to obtain the service state to determine whether you are
running the CM server as an application or a Windows service.

In server versions prior to version 3.0.2004.1, the CM server functioned as a Windows service. Versions 3.0.2004.1
and later function as a Windows application. The 2004A CM server installation, by default, will stop a previous instance
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of the Windows service, remove the service from the system, then configure the Windows application to take its place.
If preferred, you can override this new default and continue to use the Windows service. Even though the Windows
service is not configured into the system, it is still installed with ADS 2004A.

If the service is not running, the following message appears on the display:

CM Service version info: 3.0.2004.1, Installation path: C\Program Fil es\Agilent\Connecti on Manager
Server\ Msnt Srvc. exe

Coul d not get service status. Systemerror recorded: The service has not been started.

If the service isn't installed, the following message appears on the display:

Coul d not read service registry key. Systemerror recorded:

IO Libraries Information

This section records the IO Libraries registry information. This is a complete description of all IO configuration
settings. This section contains IO libraries installation path, version, and configured interfaces, as shown (important
entries are highlighted):

IO Libraries set up correctly
IO Libraries version: M01.01.04, Installation directory: C\Program Files\Agilent\10O Libraries
Agilent Visa is primary: True
IO Libraries registry information...
Regi stry key: CurrentVersion
Regi stry nane: Platform Registry value: -1
Regi stry nane: Pl atfornmNane, Registry val ue: unknown
Regi stry nane: BaseDir, Registry value: C\ProgramFiles\Agilent\1O Libraries
Regi stry nanme: CurrentVersion, Registry value: M 01.01.04
Regi stry nane: CurrentVersionNunmber, Registry value: 1291911428
Regi stry nane: Product Code, Registry value: \{04107B50- CCF1-11D3-931C-00108301D203\}
Regi stry nane: InstallLevel, Registry value: 256
Regi stry name: 1394Versi onCheck, Registry value: 5.0.2195. 2096
Regi stry nane: |OLibrariesVisaPresent, Registry value: 1
Regi stry nane: | OCFGReboot Val, Registry value: 0
Regi stry nane: | OControl Hi dden, Registry value: 0
Regi stry key: Aliases

Regi stry nane: Serial, Registry value: ag232i
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Regi stry nane: ag82341, Registry val ue: ag341i
Regi stry nane: hp82341, Registry val ue: ag341i
Regi stry nane: hp82340, Registry val ue: ag341li
Regi stry nane: e2071a, Registry val ue: ag341i
Regi stry nanme: 82340, Registry val ue: ag341i
Regi stry nane: 82341, Registry val ue: ag341i
Regi stry nane: ag82350, Registry val ue: ag350i
Regi stry nanme: hp82350, Registry val ue: ag350i
Regi stry nanme: 82350, Registry val ue: ag350i
Regi stry nane: e2078a, Registry val ue: ag350i
Regi stry nane: hpe8491, Registry val ue: ag491i
Regi stry nane: age8491, Registry val ue: ag491i
Regi stry nane: e8491, Registry val ue: ag491li
Regi stry nane: hpilan, Registry value: agtlan
Regi stry nane: hptcpi, Registry value: agtlan
Regi stry nane: agilan, Registry value: agtlan
Regi stry nane: agtcpi, Registry value: agtlan
Regi stry nane: usb488, Registry val ue: agUsb488
Regi stry nanme: 82357, Registry val ue: ag357i
Regi stry key: | NTF1
Regi stry nane: Nane, Registry val ue: gpi b0
Regi stry nanme: VI SANane, Registry val ue: GPlBO
Regi stry nane: VI SAlIntfType, Registry value: GPIB
Regi stry nane: VI SAAut oConfi gDriver, Registry value: AUTOCF
Regi stry nanme: VI SAAut oConfi g, Registry value: System Byte[ ]
Regi stry nane: LU, Registry value: 8
Regi stry nane: Interface, Registry value: 82357
Regi stry nane: BusAddr, Registry value: 21
Regi stry nanme: SysCtl, Registry value: 1
Regi stry nane: Slot, Registry value: 0
Regi stry nane: Ti meout Fl oor Msec, Registry val ue: 2000
Regi stry nanme: Ti meout UsbFl ushMsec, Registry val ue: 2000
Regi stry nane: Ti neout W Conpl et eFl ushMsec, Regi stry val ue: 15000

Regi stry nane: | OBufferSizekKb, Registry value: 64
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Regi stry nanme: PNPvid, Registry value: 0x00000957
Regi stry nane: PNPnodel, Registry val ue: 0x00000107
Regi stry nanme: PNPsn, Registry val ue: US42251605
Regi stry nane: Enabl eExport, Registry value: System Byte[ ]
Regi stry key: VI SADev
Regi stry key: VISAlIntfRsrc
Regi stry key: GPIBO::|NTFC
Regi stry nane: Driver, Registry value: |INSTR
Regi stry nane: Prefix, Registry value: |INTFC
Regi stry key: | NTF3
Regi stry nane: Nanme, Registry value: |an
Regi stry nane: LU, Registry value: 30
Regi stry nane: Interface, Registry value: agtlan
Regi stry nane: VI SANanme, Registry value: TCPI PO
Regi stry nane: VI SAlntfType, Registry value: TCPIP
Regi stry nane: VI SAAut oConfi gDriver, Registry value: AUTOCF
Regi stry nane: VI SAAut oConfig, Registry value: System Byte[ ]
Regi stry nanme: log errors, Registry value: 1
Regi stry nane: |lan_delta, Registry value: 25
Regi stry nane: sicl_infinity, Registry value: 120
Regi stry nane: |anProtocol, Registry value: 1
Regi stry nane: Slot, Registry value: O
Regi stry nane: BusAddr, Registry value: 0
Regi stry nane: sigio, Registry value: 0
Regi stry nane: Enabl eExport, Registry value: System Byte[ ]
Regi stry key: VI SADev
Regi stry key: TCPIPO: :123. 456. 789. 101: : i nst0
Regi stry key: TCPIPO: : 123. 456. 789. 101: :i nst 0: : I NSTR
Regi stry nane: Driver, Registry value: |INSTR
Regi stry nanme: Prefix, Registry value: |INSTR
Regi stry key: VISAIntfRsrc
Regi stry key: | NTF4

Regi stry nane: Nanme, Registry val ue: usbO
Regi stry nane: VI SANane, Registry val ue: USBO

Regi stry nane: VI SAlntfType, Registry value: USB
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Regi stry nane: VI SAAut oConfigDriver, Registry val ue: AUTOCF

Regi stry nane: VI SAAut oConfi g, Registry value: System Byte[ ]

Regi stry name: LU, Registry value: 20

Regi stry nane: Interface, Registry value: usb488

Regi stry nane: Enabl eExport, Registry value: System Byte[ ]

Regi stry key: Usb488Devi ces

Regi stry key: VI SADev

Regi stry key: VISAIntfRsrc

Regi stry key: PARAMS

Regi stry nane: ag232i, Registry value: LU, Nane, | nterface, Not Used, Port Nurmber, SRQ
HWFI owCont r ol

Regi stry nanme: ag341i, Registry value: LU, Nane, |nterface, Sl ot, BusAddr, Sw t ches, SysCt 1, | RQ,
PNPvi d, PNPsn

Regi stry nanme: ag350i, Registry value: LU, Nane, |nterface, Sl ot, BusAddr, PNPvi d, PNPMbdel ,

PNPsecl d, PNPsn, SysCt |, PNPpr ef i x

Regi stry nane: ag491i
Rsr cMWngr Del ay, VmeBt o, VmeBusReqLvl
UseAl | Ext endedMem

Regi stry val ue:

Regi stry nane: agtlan, Registry val ue:
| an_del ta, sigio,log_errors, reserved, | anPr ot ocol

Regi stry nane: agl ansvr,
| og_errors, | og_| ocks_conns, keepal i ves

Regi stry val ue:

Regi stry nanme: agUsb488, Registry val ue:

Regi stry nane: ag357i, Registry val ue:

Regi stry key: VI SAlnfo

Regi stry nane: Regi stry val ue: Conmment: General

1

Regi stry nane: Spec Version,

Regi stry nane: Manuf acturer,

Regi stry val ue:

Regi stry val ue:

LU, Nane, | nt er f ace, Not Used, Not Used, Cagel dHi , Cagel dLo,
Ext G ockEnabl e, Ext Tri gQut Pol ari ty, Ext Tri gl nLevel , Ext Tri gl nPol arity,

LU, Nane, | nterface, Sl ot, BusAddr, sicl _infinity,

LU, Nane, I nterface, Sl ot, BusAddr, sicl _infinity,

LU, Nane, | nt erface, Sl ot, BusAddr

LU, Name, I nt er f ace, Sl ot, BusAddr, PNPvi d, PNProdel , PNPsn

Information on Agilent's VISA | npl ementation

3145728

Agi | ent Technol ogi es

Regi stry nane: Copyright, Registry value: Copyright Agilent Technol ogi es, 2003.
Regi stry nane: ManfVersion, Registry value: M O01.01. 04
Regi stry nane: LastMd, Registry value: Fri Apr 30 10:34:17 2004
Regi stry name: MddTool, Registry value: Agilent VISA Configuration Tool
Regi stry nane: Manf Versi onNor, Registry value: 1291911428
Regi stry nane: ManflD, Registry value: 4095
Regi stry nane: Loggi ng, Registry value: OFF
Regi stry nane: MaxSessNbr, Registry val ue: 256
Regi stry nane: MaxNor Of Procs, Registry value: 64
Regi stry nane: Defaul t QSize, Registry value: 50
Regi stry nane: Sl eepMs, Registry value: 0

58




Advanced Design System 2008

functions

Regi stry nanme: Default LockWait, Registry value: 0O

Regi stry nane: Defaul t Al |l owLocal SpaceFi f o,
Regi stry key: DefaultlntfRsrcs

Regi stry nanme: , Registry val ue:

Regi stry key: BACKPLANE

Regi stry nane: DrvrName, Registry val ue:

Regi stry nane: PrefixNane, Registry val ue:

Regi stry nane: GPIB, Registry val ue:

Regi stry nanme: VX, Registry val ue:

Regi stry nane: GPIB-VXI, Registry val ue:

Regi stry nane: ASRL, Registry val ue:

Regi stry name: TCPI P, Registry val ue:

Regi stry nane: USB, Registry val ue:

Regi stry key: | NTFC

Regi stry nane: DrvrNanme, Registry val ue:

Regi stry nanme: PrefixNanme, Registry val ue:

Regi stry nane: GPIB, Registry val ue:

Regi stry nane: VX, Registry val ue:

Regi stry nanme: GPIB-VXI, Registry val ue:

Regi stry nane: ASRL, Registry val ue:

Regi stry nane: TCPIP, Registry val ue:

Regi stry nane: USB, Registry val ue:

Regi stry key: MEMACC

Regi stry nanme: DrvrNane, Registry val ue:

Regi stry nane: PrefixNane, Registry val ue:

Regi stry nane: GPIB, Registry val ue:

Regi stry nane: VX, Registry val ue:

Regi stry nane: GPIB-VXI, Registry val ue:

Regi stry nanme: ASRL, Registry val ue:

Regi stry nane: TCPIP, Registry val ue:

Regi stry nane: USB, Registry val ue:

Regi stry key: Defaul tRsrcs

Regi stry nane: , Registry val ue:

ADD functions

Regi stry key: | NSTR

Regi stry value: 0O

Interface Resources to | oad during configurati on ADD

I NSTR

BACKPLANE

System Byte[ ]
System Byte[ ]
System Byte[ ]
System Byte[ ]

System Byte[ ]

System Byte[ ]

I NSTR

I NTFC

System Byte[ ]
System Byte[ ]
System Byte[ ]
System Byte[ ]

System Byte[ ]

System Byt e[ ]

I NSTR

MEMACC

System Byte[ ]
System Byte[ ]
System Byte[ ]
System Byt e[ ]

System Byte[ ]

System Byte[ ]

Resources to | oad during auto-connect and configuration
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Regi stry nane: DrvrNane, Registry value: |INSTR
Regi stry nane: PrefixNane, Registry value: |NSTR
Regi stry nane: GPIB, Registry value: System Byte[ ]
Regi stry nane: VX, Registry value: System Byte[ ]
Regi stry nane: GPIB-VXl, Registry value: System Byte[ ]
Regi stry nane: ASRL, Registry value: System Byte[ ]
Regi stry nane: TCPIP, Registry value: System Byte[ ]
Regi stry nane: USB, Registry value: System Byte[ ]

Regi stry key: SOCKET
Regi stry nane: DrvrName, Registry value: |NSTR
Regi stry name: PrefixNanme, Registry val ue: SOCKET
Regi stry nane: GPIB, Registry value: System Byte[ ]
Regi stry nane: VX, Registry value: System Byte[ ]
Regi stry name: GPIB-VXI, Registry value: System Byte[ ]
Regi stry nanme: ASRL, Registry value: System Byte[ ]
Regi stry nane: TCPIP, Registry value: System Byte[ ]

Regi stry nane: USB, Registry value: System Byte[ ]

The diagnostics routine reads this information out of the registry key HKEY_LOCAL_MACHINE\SOFTWARE\Agilent\IO
Libraries\CurrentVersion.

Agilent IO Libraries version M.01.01.04 is included with ADS 2004A and ADS 2003C.

To return the configured interfaces information, the routine dynamically loads the visa32.dll library and queries the
interface. To return the local interfaces information, the routine loads the sicl32.dll library and queries the logical unit
information.

For Plug and Play drivers to work correctly, VISA must be installed and the Agilent VISA library has to be configured
as Primary.

With regards to the entry Registry key: TCPIP0::123.456.789.101::inst0, when you add a device to the IO
Configuration using the Edit VISA Configuration dialogs, each device entry is recorded in the registry.

If visa32.dll is not in the system path or has had its name changed IO Libraries not set up correctly.

The most common reason for this error is that the IO libraries did not install visa32.dll into a directory in the system
path.

Another common reason for this error is that the IO libraries are not installed with Agilent Visa as the primary Visa
implementation.

System error recorded: The specified nodul e coul d not be found.

IO Libraries version: MO01.01.04, Installation directory: C:\Program
Fil es\ Agi |l ent\ 1O Libraries

Agilent Visa is primary: False

This system needs to renove the 1O Libraries and re-install wth Agilent
Visa as primary.
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Coul d not generate interface information.

The most common cause for this error is that the IO libraries Visa installation is incorrect.

Service Account Information

This section contains IO libraries installation path, version, and configured interfaces, as shown (important entries are
highlighted):

Servi ce account as configured in the registry: Local System

Runni ng as Local System This is a potential problem as running as Local System on
sonme systens causes instrunment 1Oto fail

Privil eges. ..
SeTcbPrivil ege, Act as part of the operating system
SeCreat eTokenPrivil ege, Create a token object
SeTakeOaner shi pPri vil ege, Take ownership of files or other objects
SeCreat ePagefil ePrivilege, Create a pagefile
SeLockMenoryPrivil ege, Lock pages in menory
SeAssi gnPri maryTokenPrivi |l ege, Replace a process |evel token
Sel ncreaseQuot aPrivil ege, |ncrease quotas
Sel ncreaseBasePriorityPrivilege, Increase scheduling priority
SeCr eat ePer manent Pri vil ege, Create pernmanent shared objects
SeDebugPri vi | ege, Debug prograns
SeAudi t Privil ege, Cenerate security audits
SeSecurityPrivil ege, Manage auditing and security |og
SeSyst enEnvi ronnment Privil ege, Mdify firmmvare environnment val ues
SeChangeNot i fyPrivil ege, Bypass traverse checking
SeBackupPrivil ege, Back up files and directories
SeRestorePrivilege, Restore files and directories
SeShut downPri vi |l ege, Shut down the system
SeLoadDri verPrivil ege, Load and unl oad device drivers
SeProfil eSi ngl eProcessPrivilege, Profile single process
SeSystenti mePrivil ege, Change the systemtine
SeUndockPri vi | ege, Renpbve conputer from docking station

SeManageVol unmePri vi | ege, Perform vol une nai nt enance tasks
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Sel mper sonat ePrivil ege, |Inpersonate a client after authentication

SeCreat ed obal Privil ege, Create global objects

Running the server under the Local System account on certain systems prevents the system from loading visa32.dll. If
the I0 is not functioning and all the IO libraries information is correct, run the service under an account with
Administrator privileges.

Drive Types

As a security precaution, runtime versions of .NET will not allow running networked applications from removable
media. Attempting to run the CM server from a removable drive will fail and issue a security exception.

Enunerating drive types...

C. Drive type: Fixed

D: Drive type: CdRom-- the server will not work when installed on this type of drive

R Drive type: Renpbte -- the server will not work when installed on this type of drive

S: Drive type: Renpte -- the server will not work when installed on this type of drive
Processes

This section contains a list of running processes. Important entries are highlighted, as shown:

Snapshot of running processes...
Msnt Srve, Process id: 1280
Di agnosticServi, Process id: 744
CMD, Process id: 2080
nst ask, Process id: 956
CTEMON, Process id: 1704
i procsvr, Process id: 2024
SMSS, Process id: 204
TASKMER, Process id: 2128
ati 2evxx, Process id: 628
adci st, Process id: 1696

| DA, Process id: 1588
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Msnt Srvr, Process id: 2056
Directcd, Process id: 1692
w nvnc, Process id: 1048

| DASched, Process id: 1740
i proc82357, Process id: 936
PageM ||, Process id: 732
LSASS, Process id: 292

W nMWnt, Process id: 1040
svchost, Process id: 504
OSA, Process id: 1572

Creat eCD50, Process id: 1676
mdm Process id: 712

SERVI CES, Process id: 280
nut srv4, Process id: 916
expl orer, Process id: 1448
WZQKPI CK, Process id: 1768
VPTray, Process id: 1660

It moh, Process id: 1552
CVD, Process id: 1764
NMSSvec, Process id: 800
epsilon, Process id: 1292
SynTPEnh, Process id: 1332
real sched, Process id: 1652
CMSer ver Di agnos, Process id: 1972
SynTPLpr, Process id: 1436
regsvc, Process id: 352

Def Wat ch, Process id: 676
Eudora, Process id: 1744
SMrray, Process id: 1636
Itnmsg, Process id: 1528

ati ptaxx, Process id: 1420
svchost, Process id: 456
CSRSS, Process id: 232

W NLOGON, Process id: 228

CMVMD, Process id: 2160
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Crypserv, Process id: 660
spool sv, Process id: 552
Rt vscan, Process id: 872

i proc488, Process id: 2048
PROVbn, Process id: 1512
EABSERVR, Process id: 1508
CVD, Process id: 116
System Process id: 8
prpcui, Process id: 1612
bash, Process id: 752

Idle, Process id: O

For the IO libraries to work, the processes named iprocsvr , iproc488 , and iproc82357 must be running. In 2003C, if
these processes are not running, the CM server will start them. Prior to that, the processes started when somebody
interactively logged into the server PC. If 10 isn't working, one potential problem in 2003A is that no user is logged
onto the server PC.

Directory Contents

This section contains a list of the server installation directory contents and revision information for each file. The
measurement DLLs are in the ImportedAssemblies directory. The CM server revision for 2004A is 3.0.2004.1.

Directory contents...
C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Agilent. TMramework.dll, Version: 1.0.4230.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager
Server\ Agi | ent. TMFr amewor k. | nstrunment Dri ver I nterop.dl |, Version: 1.0.4230.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager
Server\ Agi | ent. TMFr amewor k. | nstrunent | O Configuration.dll, Version: 1.0.4230.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Agilent. TMrramewor k. I nstrunentl Q. dl |, Version:
1.0.4230.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager
Server\ Agi | ent. TMFr anewor k. | nstrunent |1 O Vi sal nterop.dl |, Version: 1.0.4230.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Agilent. TMrramework.Internal Utils.dll, Version:
1.0.4230.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\CMDi agnostics.dll, Version: 3.0.2004.1
C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\CMServer D agnostics.dll, Version: 3.0.2004.1
C:.\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\HaCatal og.dll, Version: 0.0.0.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\lsAdm n.dll, Version: 3.0.2004.1
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C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\LibMr.dll, Version: 3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Msmt Events.dll, Version: 0.1.0.0

C.\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\ Power Managenent.dl |, Version: 3.0.2004.1
C.\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\VisalOdll, Version: 3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\vsassert.dll, Version: 7.0.9466.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\CMController.exe, Version: 3.0.2004.1
C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Msnt Srvc. exe, Version: 3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Msnt Srvr.exe, Version: 3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Vi sal nst Fi nder.exe, Version: 3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager
Server\ | nport edAssenbl i es\ AGE444XAVxXi pnpNETW apper.dl |, Version: 1.0.0.0

C.\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenblies\Agilent8753.dll, Version:
0.0.0.0

C.\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenbli es\ ESGBServer.dll, Version:
3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenbli es\ ESGCServer.dll, Version:
3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenbl i es\ HP856XEVxi pnpNETW apper . dl |,
Version: 1.0.0.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\|nportedAssenbl i es\ HP859XEVxi pnpNETW apper . dl |,
Version: 1.0.0.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\|nmportedAssenbli es\ HP871XVxi pnpNETW apper.dl |,
Version: 1.0.0.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenbl i es\ HPE4406Vxi pnpNETW apper . dl |,
Version: 1.0.0.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenbl i es\ HPESGvxi pnpNETW apper . dl |,
Version: 1.0.0.0

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenblies\ ScopeServer.dll, Version:
3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenbl i es\ Sparnterver.dll, Version:
3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenblies\ SparnServer PNA. dl |, Version:
3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenblies\ SpectrunServer.dl|, Version:
3.0.2004.1

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\| nportedAssenblies\VSAServer.dl |, Version:
3.0.2004.1

Plug and Play Driver Information

This section contains a list of the VISA Plug and Play drivers and revision information for each file. ADS measurements
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require the highlighted DLLs shown below.

Plug and Play driver installation
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi
C:\ Program Fi | es\ VI SA\ wi nnt\ bi

C:\ Program Fi | es\ VI SA\ wi nnt\ bi

directory: C \Program Files\VI SA\wi nnt.

C:\ Program Fi | es\ VI SA\ wi nnt\ bi n\ AGB75XVxi pnpNETW apper.dl |, Version: 1.0.0.0
n\ AGE444XAVxi pnpNETW apper.dl |, Version: 1.0.0.0
n\ aged444xa_32.dl I, Version: 1.0.0.1
n\ hp548xx_32. dl |
n\ hp856xe_32.dll, Version: 1.0.0.0
n\ hp859xe_32.dll, Version: 1.0.0.0
n\ hp871x_32. dl |
n\ hpe4406_32.dl 1, Version: 1.0.0.1
n\ HPESGVxi pnpNETW apper . dl |, Version: 1.0.0.0
n\ hpesg_32.dll, Version: 1.0.0.1
n\ hpgpvx32.dll, Version: 77.1.1.4
n\ag875x_32.dll, Version: 1.0.0.1

C:\ Program Fi | es\ VI SA\ wi nnt\ bi

Module Information

This section contains a list of the modules loaded into the MsmtSrvr.exe process. This information contains the
versions of system and measurement libraries the server actually has loaded in memory.

Modul e i nformation for
Modul e name: Msnt Srvr. exe
File:

I nt er nal Name: Msnt Srvr. exe
Original Fil enane: Msnt Srvr. exe
Fi | eVersi on: 5.0.2006. 1

Fil eDescription: Agilent Connecti

Pr oduct : Agi | ent Connecti
Product Ver si on: 5.0.2006. 1
Debug: Fal se

Pat ched: Fal se

PreRel ease: Fal se

Pri vat eBui | d: Fal se

Msmt Srvr. ..

C:\ Program Fi | es\ Agi | ent\ Connecti on Manager Server\Msnt Srvr.exe

on Manager

on Manager
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Speci al Bui | d: Fal se

Language Language Neutr al

Modul e name: ntdl | . dll

File: C.\ W NDOWE\ systenB2\ ntdl | . dl |

| nt er nal Nane: ntdll.dll

Oiginal Fil enanme: ntdll.dll

Fi | eVer si on: 5. 1. 2600. 2180\ (xpsp_sp2_rt m 040803- 215\ )
Fi | eDescription: NT Layer DLL

Pr oduct : M crosof t # W ndows# Operating System

Pr oduct Ver si on: 5. 1. 2600. 2180

Debug: Fal se
Pat ched: Fal se
PreRel ease: Fal se
Pri vat eBui | d: Fal se
Speci al Bui | d: Fal se
Language English (United States)

System Information

This section contains a description of the server PC memory, operating system, and processor. Important entries are
highlighted, as shown:

Menory information...
Total Physical Menory: 527941632
Free Physical Menory: 281899008
Total Page File: 1289859072
Free Page File: 1006911488
Total Virtual Menory: 2147352576
Free Virtual Menory: 1947172864
Operating systeminformation...
M crosoft W ndows XP
Uni processor Free
Service Pack 1
Processor information...

Regi stry key: 0
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Regi stry nane: Conponent Information, Registry value: System Byte[ ]
Regi stry nane: ldentifier, Registry value: x86 Fanmily 15 Mdel 2 Stepping 4
Regi stry nane: Configuration Data, Registry val ue:

Regi stry nane: ProcessorNaneString, Registry val ue: Intel ® Pentiun® 4 Mbile CPU
1. 70G#

Regi stry nane: Vendorldentifier, Registry value: Genuinelntel
Regi stry nane: FeatureSet, Registry value: 12287

Regi stry nane: ~Miz, Registry value: 1694

Regi stry nane: Update Status, Registry value: 0

Regi stry nane: Update Signature, Registry value: System Byte[ ]

Regi stry nanme: Previous Update Signature, Registry value: System Byte[ ]

New, higher-speed computers with fast HPIB interfaces can overload old, slower instruments. By recording the
processor clock speed and the IO Libraries information above, EEsof support engineers can help diagnose these data
overflow problems.

If the PC has more than one processor, there will be additional entries with headings like Regi stry key: 1 and so on.

Operational and Functional Concepts

This chapter offers detailed information on the operational theory of the Connection Manager, including client-server
architecture, server operational modes, removal, and installation, and detailed explanations of the measurement
dialogs.

Client-Server Architecture

In its basic form, the client/server is a computational architecture involving a client process requesting a service from
a server process.

Client-server architecture is referred to as a logical extension of modular programming, which recognizes that
software can be broken into its constituent parts for manageability purposes. With client-server architecture this is
carried a step further by acknowledging that the modules do not need to execute within the same memory space. This
enables the client and the server to run on the hardware and software programs best suited for their individual
functions.
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In the case of Connection Manager, this allows the server to utilize a wide variety of instrument-control capabilities
only available on the Windows platform, while the client can be accessed from any platform that supports ADS.

Functional Process

In this architecture, the client sends a message to the server, requesting that the server perform a task. The client
provides the user-interface portion of the application, validates data entered by the user, sends requests to the server
programs and can execute business logic.

The server program receives requests from the client, manages the interaction between the client and any connected
instrumentation, retrieves and updates information, manages data integrity and dispatches responses to client
requests.

The Connection Manager Client operates in conjunction with an ADS project. The datasets and other files generated
from measurements reference the ADS project and project data directories.

The client caches the discovery dialog contents. For example, start the Remote Instrument Explorer and point it at a
specific workstation (for example, myserver ), then select the close icon in the title bar to dismiss it. The next time the
Remote Instrument Explorer is opened and pointed at myserver, the client recalls the last information stored on the
Connection Manager client about myserver's contents. This prevents a potentially time-consuming conversation
between the client and server every time a discovery dialog is opened.

B Note

To get the latest view of the server configuration, on the measurement panel click Refresh .

Data Interface

For a client to communicate with the server, they must agree on a common endpoint for the communication. That
common end point is a network port number. The port number is a unique number the server uses to allow
Connection Manager client connections to particular services. By default, the server accepts client requests on port
4790.

The port number is defined within the MsmtSrvr.exe.config file located in the server installation directory, by default,
C: \ Program Files \ Agilent\Connection Manager Server \ MsmtSrvr.exe.config .

The contents of the default configuration file are:

<confi guration>
<appSettings>
<add key="port" val ue="4790"/>
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</ appSettings>
</ configuration>

To change the default port number, see Changing the Default Server Port Number.

Connection Manager Server

The Connection Manager (CM) Server is one half the Connection Manager client/server environment. By default, the
CM server runs as an Windows program. To run the server as a Windows service , see Running the Server as a
Windows Service.

Because the server uses Windows-based supporting applications, it requires installation on a PC running a version of
Microsoft Windows 2000 Professional or Windows XP Professional (or one of its successors).

The Connection Manager Server consists of two cooperating processes: CMController.exe and MsmtSrvr.exe . These
processes work together to create the Windows program user interface, provide instrument connectivity, and to
manage application behavior.

The CMContoller.exe Process

CMController.exe is the main server process. It allows the CM server to run as a Windows program. CMController.exe
produces the server user interface, the Agilent Connection Manager Server dialog and controls the lifetime of the
MsmtSrvr.exe process.

During installation, the Windows executable that produces the Agilent Connection Manager Server dialog is placed into
the Windows system startup group. The server starts automatically whenever you log on to the server PC.

When the Connection Manager server starts, the process examines the server PC configuration and displays the
results in the Agilent Connection Manager Server dialog.

The process first checks to ensure the required support products are correctly installed and properly configured, then
displays the results in the Required Conditions group box. If a component is missing or incorrectly configured, the
dialog displays the problem condition in red.

Next, the process checks for installed instrument drivers and displays the results in the Optional Components group
box. A check appears in the box in front of an installed driver. Instrument drivers are needed only for specific
measurements, so in some cases, unnecessary drivers are not installed.

The Agilent Connection Manager Server dialog provides menu access to selections that control server functionality.
These menus (File, Control, Diagnostics, and Help) provide access to server shutdown, restart, configuration
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diagnosis, and documentation, respectively.

The diagnostics function collects data on the installation and configuration of supporting applications, interface
configuration, and account information. After diagnostics are run, the results are saved as a file that can be delivered
to Agilent support engineers to aid in troubleshooting connectivity problems.

The MsmtSrvr.exe Process

The MsmtSrvr.exe is a Microsoft .NET application that uses a networked interface capability called remoting .
Remoting is the ability for a Microsoft .NET component to appear as if it is running locally in a client, when it is
actually running remotely in another process.

Understanding IO Configuration

The Connection Manager's server uses the Agilent IO Libraries to achieve instrument communication. For the 10
Libraries to communicate with the instrument interfaces, there must be one or more background processes (referred
to as daemons) running on the server PC.

The IO Libraries installation usually puts a shortcut to this daemon in the system startup group of the Windows shell.
This shortcut starts the 10 Libraries daemon when you log onto the server PC.

If a user tries to log into the server PC while the server is running in the background, the system startup group tries
to start the IO Libraries daemons a second time, which brings up the following dialog:

Agilent 10 Libraries Control -

D ] ) The 12 control is already running,

Click "Yes' if vau wish ba exit and restart i,
Click ‘Mo’ o continue using Ehe current instance,

Click the '12" icon on the Windows taskbar to use the IO Cantral,

Yes | [0} I

B Note

When this dialog presents itself, click No . Otherwise, there will be two IO control applications running.

Viewing Installed IO Libraries
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To view which version of the IO Libraries you have installed, complete the following steps.

1. In the server's Windows system tray, select IO > View Documentation > Installation and Path Information .
2. Observe the Agilent IO Libraries Installation and Path Information dialog.

Agilent 10 Libraries Installation and Path Information

i J Version M, 01.01.04
Installed

Agilent SICL:

Agilank YISA: Installed as primary YISA

non-Agilent YISA:  Nok Installed

SICL Path: ‘E:\Program Files\Aglent|10 Libraries'
YISA Path: 'E:\Program Files\VISA'

Reqgistry Path: 'HEEY _LOCAL _MACHINE | SOFTWAREY Agilert| IO Librariesh Currentiersion’

Lo« |

Supported Instrument IO Interfaces

The supported Agilent IO interface hardware matrix can be found at:

http://www.home.agilent.com/upload/cmc_upload/All/Interface Support Matrix.pdf

Information on configuring the Agilent IO Libraries is available from:

http://www.agilent.com/find/iolib

Select the IO Libraries Installation and Configuration Guide for Windows link and go to Configuring IO Interfaces. This
chapter has detailed configuration steps for the supported I0 interfaces.

Additional Resources

For more detailed information on IO configuration, refer to the documentation for the IO libraries.

To view the documentation, in the Windows task bar, select I0 > View Documentation .

Changing the Server Default Port Number from the Server

To change the server port, change the number in the value field of the port configuration key.
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For example, to modify the server to listen on port 5885, modify the value in MsmtSrvr.exe.config :
<add key="port" val ue="5885"/>

You must restart the server to initiate the port number change. To restart the server, in the Agilent Connection
Manager Server dialog, click Control > Restart Server .

B Note

You can view the currently active ports on the server by typing the command netstat -a into a command line
window. This yields a list of bound ports including the Connection Manager server ports:

TCP dudet op: 4790 0.0.0.0:0 LI STENI NG
TCP dudet op: 4791 0.0.0.0:0 LI STENI NG

Overriding Windows Power Management Functionality

Windows 2000 and later versions of the Windows operating system include a power management facility that turns off
the display and puts the PC into a low-power state after extended periods without activity.

The Connection Manager server is intended to operate for long periods of time unattended. The IO Libraries cannot
perform instrument communications once a PC has transitioned to a low-power state. Therefore, at startup, the server
issues a command preventing the operating system from transitioning to low-power states while allowing the monitor
to turn itself off.

Once the server's main thread has finished running, it issues another command enabling the operating system to
again transition to a standby or hibernate state.

Running the Server as a Windows Service

In ADS 2004A, the Connection Manager server runs as a Windows application. If preferred, the server can run as a
Windows service, as in earlier implementations.

B Note

The Windows service cannot be configured into the Windows system, as both the Windows service and the
Windows application cannot control the MsmtSrvr.exe lifetime.

To configure the server to run as a service, complete the following steps.

1. Open a Windows session running under an account that has Administrator privileges.
2. Right click on the Windows Start button, then select Explore All Users .
3. Select the Programs icon, then the Startup icon.
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4. Right click the Agilent Connection Manager Server icon and select Properties .

The CM server installation directory in listed in the Target field in the Properties dialog. Record the directory
where the CM server is installed.

Remove the Agilent Connection Manager short cut from the Windows System Startup program group.

From a command prompt, change directories to the directory you recorded above.

Run the command Msnt Srvc -install

Run the command Msnt Srvc -start .

The process owner is listed as AUTHORITY\SYSTEM. The System account in Windows is a privileged account,
similar to the Super User account in UNIX. Many Windows services are configured to run under the security
context of this account.

@ Now

You can configure the environment under which the Windows Service runs to restrict its access privileges to those of a
particular login account. You can configure the service to start when the server workstation boots or require someone
to specifically start it. To configure a Windows Service select Administrative Tools > Services from the Windows
Control Panel.

1 -
¥, Services

Action  Yiew - = | 55| m |y m I m

Tree | Flame [ Descripbion | Status | Skarbup Tvpe | Log On As |*

% Services (Local) e S Agilent Connection ... Started Mariual LocalSyskem
S Alerter Motifies sel... Manual Local=ystem =
E%}.|!'.|:||:|Iin:aI:in:nn Manage... Provides s... Marial LocalSystem
%Ati Hakk ey Poller Started Aukarnatic LocalSystem
%.ﬁ.utamatic Updakes Enables th... Started Aukarnatic LocalSystem
%Backgmund Intelig... TransfersF... Maral LocalSystem
E%}CIith:u:uk Supports ... Marwal LocalSystem
é%}CQF‘-‘H Event System  Prowvides a... Started Marwal LocalSystem
E%}Cu:umpu_lter Browser Maintains a... Started Aukormatic LocalSystem
88 Connected Launcher Started Autormnatic LocalZystem
%Cunnected Reglap Connected... Started Aukomatic LocalSystem j

In the preceding illustration, the Startup Type is set to Manual . In this mode, the service requires someone to

specifically start this service. When the type is set to Automatic , the service starts whenever the workstation is
booted. Once a service is started, it remains running until specifically stopped. This allows a service to run and

perform whatever activity it is responsible for, independent of whether other users log onto or off of the server
workstation.

© Note

By default, this service starts automatically.

The security environment is set in the Log On section of the Properties dialog in Windows 2000. To open this dialog:

1. Select a process (i.e., Connection Manager).

2. Choose Action > Properties from the Services toolbar.

3. Choose the Log On tab at the top of the dialog.
This section determines what security environment a service (and any processes it spawns) uses while running.
The System account, as previously stated, is privileged.
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Agilent Connection Manager Properties {Local Computer) [ 7]

Gereral LogOn ] Heu:u:uveny] Depem:lenc:iesl

Log on az:

+ Local System account
[V Allow service to interact with deskiop

" Thiz account: [ |
|
|

You can enable o disable this service for the hardware profiles listed below:

Hardware Prafile Service
Undacked Prafile Enabled
Dacked Profile Enabled
Docked Profile 2 Enabled
Dacked Profile 3 Enabled
| Disable |

Ok I Cancel | |

The selection labeled This account runs the service under the account privileges of a distinguished principle (e.g.,
some login account other than System). When configured this way, the server inherits the named account's
access privileges. Services running under the account privileges of a distinguished principle cannot open windows
on the interactive desktop.

When the service is running, error and informational messages are reported using the Windows Event Log. To use the
Event Viewer application, on Windows 2000 task bar, select Start > Settings > Control Panel > Administrative Tools >
Event Viewer.

To view the Connection Manager event log entries, switch the Event Viewer to its Application mode and search for
entries with the Source category of AgilentConnectionManager .
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H Event ¥Yiewer HE' E
fiction  View S - M =
Tree | Apphcation Log 2,083 event(s)
}n_'ﬂ Event Yiewer (Local) Type | Dake | Time | Source | Cateqory | Event | ser &
il Application Log i"'. W.arning 42212003 7:07:05 AM  WinMgmt Mone 41 TEY =
i Security Log i"; Warning 4[2212003 Ti0F05 AM WinMgrmk Mone 41 A
i| System Log {,J Information  4/22/2003 70704 AM EvnbAgnt Mone 2018 MJA
A\ Warning 4j22/2003 7:07:03 M WinMgmt Mone 41 My
(N warning 4{22)2003 7107:038M  WinMgnt None 41 T
-!:J Information  4f22/2003 70656 AM  Scedli Mone 1704 I
-!:J Information 4222003 Fi06:46 AM  Norton Antivirus heone 14 T
A Information  4/22/2003 7106116 AM  WMDM PMSP Service MNone 105 YA
A Information  4/22/2003 7:06:14 &M YMnetbrO None 0 SYSTEM
.5) Information 42212003 Ti05:49 AM  mnmsrve More & MiA
,5) Information 412212003 70548 AM  CEReQCap one 1} MiA

& Informakion 2212003 70543 AM  AdilentConnectionManager  Mone

.5) Informaktion 4212003 9130:43 AM  Morton Antiviros Mone 7 MIA

...i) Information 4212003 Q:30:35 AM Morton Antivirus Mone 16 T

ﬁ; W arning 41212003 DETIE9AM  EventSwstem Firing Agent 4100 T

/3 warning 4/21/2003 92744 AM WinMgmt hone 41 hj

/N warning 4/21/2003 32744 AM  WinMgmt hone 41 (T

ﬁ YW arming 4f21/2003 Q2742 AWM WinMgrmk Mone 41 1f:S
i"i,Warnmq 412112003 22742 AWM WinMgrmk Mone 41 RfA Jll
4 ]

Configuring User Account Privileges on the PC

Many IT departments restrict the privileges on Local System accounts, thereby disabling Connection Manager Server
instrument communications. We strongly recommend that you do not use the Local System account to run the
Connection Manager server. Rather, the server should run under the account of a distinguished principal (i.e., a login
account other than Local System).

In addition, the supporting application Agilent VISA COM libraries require Administrator privileges on the user account.
To ensure that this condition exists, we recommend that you change the account under which the Connection Manger
Server runs.

B Note
The following example illustrates the procedure for a Windows 20000 operating system. Windows XP has
similar procedures for controlling the environment under which a service runs. The Services Control Panel
application is the starting point on all Windows operating systems.

To change the account information on Windows 2000:
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From the Windows 2000 toolbar, select Start > Settings > Control Panel .

From the Control Panel dialog, select Administrative Tools > Services .

Highlight Agilent Connection Manager , then click the Properties toolbar button.

From the Log On tab, select the This account: radio button from the Log on as: group.

AL

Agilent Connection Manager Properties ter) 2| x|

General LogOn !Fieu:u:uver_lrl Dependencies

Log on a::

£ Local Systemn account

§i7

{*' Thiz accourt; 1LDCE|5.'r'StEm

1xxxxxxxxxxxxxxx

Fazsword;

Confirm pazswaord:

]xxxxxxxxxxxxxxx

Y'ou can enable or dizable thiz zervice for the hardware profiles listed belaw:

Hardware Profile ; Service
IInhdocked Prafile Enabled
|  Disabl |
k. l Cancel ] e I _

5. Change the account name from LocalSystem to an account that has Administrator privileges. To do this, either
enter an account name, or select the name from a list by clicking the Browse... button.

© Note
You can select an account that is local to the PC running the CM server, or an account in your company's
domain. If choosing an account in your domain, that domain account must be in the local Administrators group

on the PC running the CM server.

6. To ensure that a domain account has Administrator privileges on the machine running the CM server, open the
Control Panel's Users and Passwords application.
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Users and Passwords : Rrer it ..?..L!'Ej
sers l Advanced

Lze the lisk below to grant or deny users access ta your
compuker, and ko change passwaords and ather settings.

IIsers For this compiter:

Iser Name J Damain Group
;ﬁ.ﬁ.SF‘NET SANCO40320844  Users
ﬁdnnmer SAMCO40320544

W0MEr AGILEMT fdminiskrators
ﬁGuest SAMNCO4H0320344  Guests
ﬂjaner SANCO40320844  Adminiskrators
ﬁSQLDebugger SANCO40320544 Jsers
ﬁtrixie SANCO40320344  Users

Jsers

add. .. Remove Properties |

Fassword For doomer

i To change your password, press Chrl-alk-Del and select
Change Password,

| (04 1 Cancel _1 ] |

7. Select the domain account from the Users tab, choose Properties .
8. From the Properties dialog select the Group Membership tab, choose Other: .
9. Select Administrators from the drop-down list control. Click OK.
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AGILENT'doomer Properties ! 2| x|

Group Membership

What level of access do wou want o grant this user?

" standard user (Power Llsers Group)

[=ers can madify the computer and install programs, buk
cannot read files that belong ko other users,

" Restricted user {Users Group)

Ilzers can operate the computer and save documents,
bt cannok install programs or make potentially damaging
changes to the system files and setkings.

i other: |administrakors _:j

Adrninistrators
Backup Operators
Debugger Users
Guests

MC_S ISLCK
Power Users
Replicator
sers

WS Developers

Ik | Zancel

10. Type in the account password in your Service Properties dialog. Click OK .
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Agilent Connection Manager Properties (1

General LogOn !Hecwer_u Dependencies

Log on az

™ Local System account

i._- : —— I 3 E i1 L 1) - :
{* Thiz account: i'&GlLENT\dDDmer ﬂj
Easswnrd; ]xxxxxxxxx

]xxxxxxxxx

Confirm pazswaord:

Y'ou can enable or dizable this zervice for the hardware profiles listed below:

Hardware Profile. : Service
Undocked Profile Enabled
| Didakle ]

1] I Cancel ] Apply |

11. Click Restart Service in the toolbar on the Services control panel for the new settings to take effect.

Changing the Default Server Port Number

If you are running the server as a Windows service, to have the server recognize this new value, select Agilent
Connection Manager in the Services dialog, then choose Action to stop and restart the Windows Service as shown.
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¥, Services | _ [O] x|
Action View || 4= = | & 2 m Il m

1 Marmne | Description | Status | Startup Type ] Log On As ‘-
g 2P Bk 2ailent Connection Manager Sbomatic Localsysken
%nlerter Motifies select, ., Manual LocalSystem
E—. %F’.ppktatiﬂn Managenent Provides soft... tarial LocalSystem
%.&t’r Hotkey Poller Starked Aukarmastic LocalSysterm
All Tasks ] %.ﬂ.utnmatic Updates Enables the d... Started fukarmatic LocalSyskenn
%Backgmund Intelligent Tram,.. Transfers file... Manual LocalSyskem
Refresh ipi'&liZIi|,:|EE’|:u:|I=; Supports Clip.,. Manal LocalSystem
Properties %CDM+ Ewent System Provides auta...  Started Marial LocalSystemn
%Cnmputer Erowser Maintains an ...  Started Autamatic LocalSystenm
Help 5%Cn nnected Launcher Started #ukomatic LocalSystem

‘%\?Cunnected RegCap Connected R.,.  Started Automatic LDcaIS';.rstfirn Iﬂ
1 ¢

A Windows Service sets the security environment and controls the process lifetime of the other server components.
The highlighted entry is the Windows Service. The subordinate process is the actual Connection Manager Server

(MsmtSrvr.exe), as shown.

#* Process Explorer - Sysinternals: www.sysinternals.com

File “iew Process Handle Opbons

9 E b E R

Search Help

Process [P0 [ cPu [ Descrption | Oviner | Prioty | Handles | Window 14
[ zervices. exe 20 0 Services and Controller app NT AUTHORITYWASYSTEM 9 E11
T atiZeviene 136 0 ATl External Event Utilty E.. NT AUTHORITYASYSTEM 8 H
= svchost exe 28 0 Genenc Host Process for W, NT AUTHORITYASYSTEM 8 A5
_j spoaliy_ ane 458 ] Spoole: SubSpstem App NT AUTHORITY WSYSTEM 13 200 —
I CBRegCapE<E 560 D Fegisty Capture Module WT AUTHORITYANSYSTEM B 74
HE J WT AUTHORITYNSYSTEM 8 R3]
86 0 NT AUTHORITYVASYSTEM & 34
B12 ] Connected TLM Launcher  NT AUTHORITYWSYSTEM g g2
T detwatch, exs B28 0O Winus Defiration D aeman MT AUTHORITWAWSYSTEM 8 35
1 svchost exe B2 O Genenc Host Process for W, NT AUTHORITYASYSTEM 8 478
& mnmarc, ewe E52 0 Methdeeting Remote Deskio.. NT AUTHORITYASYSTEM 8 43
M itvecanexe 7200 Mogtan Artiins MT AUTHORITYAWSYSTEM 8 223
] MzgSpeEXE 1204 O LB -~ Meszage 5pstem WT AUTHORITYSYSTEM 8 3
[ #77N Flamabe Fanizhn Sendiee MT BHTHORITYASYSTFM R 3 _|v
i iﬂ L
B Note

The Process Explorer tool is available at: http://www.sysinternals.com/

Removing the Server from the PC
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There are two methods for removing Connection Manager server from a PC workstation. The easiest method uses the
installation disc to remove the server and all other related support programs.

The other method uses Windows Add/Remove Programs dialog to remove each individual component.

To remove the server using the server installation disc

1. When the Connection Manager Server InstallShield dialog appears, choose the Remove radio button and click
Next .

2. When the program removal confirmation dialog appears, click Yes .

When the Connection Manager Server InstallShield dialog appears, click Finish .

4. When the Connection Manager Server InstallShield dialog appears, select the Yes I want to restart my computer
now radio button and click Finish .

w

Removing the server using the installation disc does not remove any of the supporting applications. These supporting
applications are considered shared system components that other applications may depend upon. To remove the
supporting applications, use the Windows Control Panel Add/Remove Programs application to remove the shared
components.

Remove these shared components in the following order:

856x Plug & Play Driver

859x Plug & Play Driver

871x Plug & Play Driver

875x Plug & Play Driver

E4406 Plug & Play Driver

E444x Plug & Play Driver

ESG Plug & Play Driver

AgilentRfSigGen IVI-COM Driver

Agilent T&M Programmers Toolkit Redistributable Package 1.1
Agilent IO Libraries, which removes VISA COM
. Microsoft .NET Framework 1.1

WoNOULhAWNE

=
= O

To remove the server using Windows Add/Remove Programs dialog

1. From the Windows task bar, select Start > Settings > Control Panel > Add/Remove Programs .

2. Select the Agilent IO Libraries and click Change/Remove . Follow the command prompts to remove the Agilent 10
Libraries.

3. Select the Agilent T&M Programmers Toolkit Redistributable Package and click Change/Remove . Follow the
command prompts to remove the Agilent T&M Programmers Toolkit Redistributable Package.

4. Select each individual Plug&Play driver and click Change/Remove . Follow the command prompts to remove each
individual Plug&Play driver.
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5. Select Agilent VisaCom and click Change/Remove . Follow the command prompts to remove Agilent VISA COM.

6. Select Connection Manager Server and click Change/Remove . Follow the command prompts to remove
Connection Manager Server.

7. Select Microsoft .NET Framework and click Change/Remove . Follow the command prompts to remove Microsoft

.NET Framework.

Reinstalling the Server on a PC

Connection Manager server can be installed and used with RF Design Environment (RFDE) and Advanced Design
System (ADS). Follow these instructions to install the Connection Manager server and configure the server I10.
Before You Begin

To communicate with instruments, you must install the Connection Manager server. Before installing the server,
ensure that your PC workstation and your EDA software licensing meet the following requirements.

System Requirements

The server must be installed on a Windows PC connected to the same network as the EDA software network server or
local installation.

B Note
Connection Manager Server cannot be installed on 64-bit machines.
Requirement Description

Processor Pentium III 450 MHz or higher

RAM 256 MB

Hard Disk Space 500 MB on system drive

Operating System Windows 2000 Professional (Service Pack 2)
Windows XP Professional (Service Pack 1)

Network Configuration TCP/IP

Supported CD-ROM required for program installation.

Media Type

Licensing Requirements

83



Advanced Design System 2008

Although the Connection Manager client requires a license, Connection Manager server does not require a license
regardless of where it is installed.

B Note

The Connection Manager client is installed during the main software installation. The link_connect_mgr license
is required to run the client from a schematic page. Connection Manager client and server installations are not
related to the client-server installation of the EDA software .

EDA Software Version Requirements

The Connection Manager client and server software must be from the same release.

If you used an older release of Connection Manager, install latest version of Connection Manager server when you
install latest version of the EDA software.

Installation Package Overview

The Connection Manager server installation installs all the software necessary to enable the EDA software-supplied
measurements. This includes:

e Run-time versions of the Agilent Test and Measurement Programmer's Toolkit. This includes the most recent
version of VISACom available when the Toolkit was released. The latest version is available from the Agilent
Developer Network at:
http://adn.tm.agilent.com

e The Agilent IO Libraries

¢ ADS Measurement Libraries

e Plug&Play and IVI-COM drivers

e Run-time versions of Microsoft .NET, suitable for running .NET application

e The Connection Manager server

Installation Types

Complete

The Complete installation installs all program features in the default installation directory C:\Program
Files\Agilent\Connection Manager Server .
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Custom

The Custom installation lets you define the installation directory and choose the optional program features, such as
the ADS Measurement Library, Connection Manager documentation, Ptolemy VEE Link Server, and VEE Service Control
Panel Application.

Installing the Server

Ensure that your PC workstation meets the system requirements.

Insert the Connection Manager Server 2004A Installation Disc into the workstation CD-ROM drive.
When the installation wizard prompts you, choose the type of installation.

Follow the command prompts to complete the installation.

AwNE

For Windows XP Service Pack 2 Systems Only

1. When the system reboots, Connection Manager Server starts and the Windows Security Alert dialog appears.
"= Windows Security Alert [Z|

To help protect your computer. . Windows: Firewall hazs blocked
7 zome features of this program,

Do you want to keep blocking thiz program?

Mare:  Agilent Connection Manager
Publisher: Agilent Technalogies |<:\Program Files\Agient\Conn

[ Keep Blacking ][ Uriblock. H Ask Me Later ]

Windows Firewall has blocked thiz program from accepling connections from the
Internet ar a network. |F you recognize the program or trust the publizher, you can
unblock. it. When should | unblock. & program?

2. In the Windows Security Alert dialog, click Unblock .

This creates an exception in the Windows Firewall that allows network connections through the firewall to the
Connection Manager server.

This completes the installation process. To connect instruments to the server workstation, complete the steps in
Configuring the Server IO on the PC.
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Using Connection Manager with Windows XP Service Pack 2

By default, computers using Windows XP Service Pack 2 will not allow access to the Connection Manager server and

VEE Service through the firewall.

If you have upgraded from another operating system version to Windows XP Service Pack 2, you must enable
connections to the PC hosting the Connection Manager server and/or VEE Service by listing them as exceptions to the

firewall.

Follow these steps to enable network connections to Connection Manager server (and VEE Pro, if necessary) through

the firewall.

1.

In the Windows menu bar, choose Start > Settings > Control Panel .

2. In the Control Panel dialog, click Windows Firewall .

B Control Panel K
Edit ‘iew Favorites” Tools Help

> __?Iﬁea'th:;'FuHBrs B
[} Cantral Panel
&"' Control Panel A

[} Switch to Category Yiew

See Also

File

o

Address

LSy stem

;Taskbar and Start Menu
81 User Accounts

HVEE Service Manager

Windows Fireveall
o Wireless Netwark Setup Wizard

-ﬁ Wiridaws Updake
) Help and Support

3. In the Windows Firewall dialog, ensure that the Don't allow exceptions checkbox is unchecked.
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*= Windows Firewall X

General :E:-:::epticuns Advanced

Wirdows Firewall i helping b piatect your PC

Windows Firewall helps protect vour compater by preventing unauthonzed users
from gaining access to your compuker thaough the Intemet or a netwark.

@ (®iDn [recommended}

Thiz zetting blocks all outside sources from connecting to thiz
computer, with the exception of those selected on the Exceptions tab.

[ ] Don't allow exceptions

Select this when pou connect to public networks in less secure
lozations. such az arpoits. You will not be notified when Windows
Firewall blocks programs. Selechons on the Exceptions tab will be
ignored.

@ ) Dff [not recommended]

Avoid uzing this setting Tumang off Windows Firewall may make this
computer more vulnerable bo vinuses and intruders.

What elze should | know about Windowes Frewall?

[ (K] i [ Cancel

4. In the Windows Firewall dialog, click the Exceptions tab.
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*= Windows Firewall X

General | Exceptions I.ﬁ.dvanced:

Windows Firewall iz blocking incoming network, connections, except for the
programsz and zervices selected below. Adding exceptions allows zome programsz

b wiark, better but might increaze your zecurity rizk.

Frograms and Services:

Hame

[ File: and Printer Sharing
Femate dssistance

[ Remote Dezktop

(1 UPHP Framework,

| AddPogam.. | | addPot. || Edt. |

Digplay a notfication when Windows Firewall blocks a program

"What are the rizks of allowing exceptions?

k. ] [ Cancel

In the Exceptions tab, click Add Program... .

In the Add a Program tab, click Browse .
Use the Browse dialog to enter the Connection Manager Server installation directory (by default, <installation

drive>\Program Files\Agilent\Connection Manager Server ).
From the Connection Manager Server installation directory, choose MsmtSrvr.exe and click Open .
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Browse

Look in; | ) Connection Manager Server b = s Pl A
: i:,:]Dncumentatbun
L EB i Importedassemblies
My Fecent M cmcontroller.exe
Documents [T MsrkSrve.exe

7 i Mk Srvr, B0
tj [jﬂuaiarvi:e.axa

[™visalnstFinder .exe

My Documents

My Computer

File name: MsmtSrmexe it ' | Dpen ]
Files of type: Applications [ eve.” com™ icd) |

kdy Metwork,

9. In the Add a Program tab, click OK .
The Windows Firewall dialog Exceptions tab shows the MsmtSrvr.exe exception.
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= Windows Firewall

| General | Erceptions I.ﬁ.dvanced:

Windows Firewall iz blocking incoming network, connections, except for the
programs and services selected below, Adding exception: allows zome programs
ko work, better but might increase your secunty nizk,

Programs and Services:

M ame

[JiFile and Printer Sharing
b zmitS rer. e

Remate Azsistance

[ Remate Desktop

O UPAP Frameswark,

[ Add Program. .. ] [ Add Paort....

Dizplay a notification when Windows Firewall blocks a program

What are the rizks of allowing exceptions?

[ ak. ][ Cancel ]

10. If you are using VEE Service, in the Exceptions tab, click Add Program... .

11. In the Add a Program tab, click Browse .
12. Use the Browse dialog to enter the VEE Pro installation directory (by default, <installation drive>\Program

Files\Agilent\VEE Pro 7.0 ).
13. From the VEE Pro installation directory, choose veesm.exe and click Open .
14. In the Add a Program tab, click OK .
15. In the Windows Firewall dialog, click the OK .

Connections to the PC hosting the Connection Manager server and/or VEE Service are now enabled as firewall
exceptions.

Connection Manager Client

Connection Manager (CM) client, is the client half of the Connection Manager client/server system. Although the server
requires a version of Microsoft Windows 2000 Professional or Windows XP Professional (or one of it's successors),
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clients can exist on any platform having TCP/IP networking capabilities.

The CM client creates ADS datasets, holds the results of S-parameter, spectrum, and voltage waveform
measurements, and provides measurement panels enabling interaction with measurements located on the server.

The client also provides instrument discovery by identifying instruments that are connected to your server
workstation. This enables the client to easily associate a particular instrument with a particular measurement.

B Note

The term measurement describes functions in a server library. Generally, a measurement includes gathering
physical data from one or more instruments, but is not limited to instrument control.

The client uses the menus to access file, server, instrument, window, and help/troubleshooting functionality.

File Menu

The File menu contains entries to save and recall application states and to exit the client. For more information, see
Understanding Application State Files.

Server Menu

The Server menu contains a single entry that allows you to specify a connection for the remainder of the Connection
Manager client session. For more information, refer to Selecting a Server Workstation and Connection Port and
Managing the Set Server Dialog from the Client.

Instruments Menu

The Instruments menu contains entries enabling dynamic instrument discovery and rudimentary interactive
instrument IO.

The Remote Instrument Explorer

This dialog queries connected instruments and lists the results of the query.
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Interactive 10

This dialog provides some rudimentary interactive instrument IO capabilities. This capability is used in troubleshooting
simple instrument connectivity problems. Selecting Server > Interactive I0 opens the Interactive IO dialog.

To communicate with a specific connected instrument, select an instrument using the Select Instrument drop-down
list.

4 Interactive 10 - port 4790 - Il:I X
Server IIu:nc:thn:nst:d?EEl Help |
Select |nstrurnent Command or Query
AB:INSTR vI Refrezh | |“:Is ll
GRIBO;T:INS

GPIB: 16N Timeoutinms  EOL Sequence
GRIBO:1E:INY

|5000 [ 4 |
EID:‘I::IE

: 'val Send Enmmandl Read Flaspnnsal Send Device Clear

Session Histary Clear Session History

You can select an instruction to send to the instrument by choosing from the Command or Query drop-down list or by
typing a command into that same field.

4 Interactive 10 - port 4790

To]x]
Server |localhost 4730 Help |

Select Instrument Command or Query

I:‘IE::INSTH 'vl Refresh “ols

_I
Timeout in| ¢ ?
"ste
[5000 stl:u?
Send and Flacuwa| Send Enmnandl Read Hespm

Session Histary tst'?'
l:al'?‘

Dpt'?
el

B Note
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The definition of the IEEE-standard commands in the Command or Query field are listed in most instrument
programming manuals. Many of these manuals are available from the Agilent Developer Network:

http://adn.tm.agilent.com.

You can specify a waiting period before an unsuccessful communication attempt is aborted by changing the value in
the Timeout in milliseconds entry field. The default is five seconds.
Different types of instruments use different character sequences to mark the end of an instruction.

The EOL Sequence drop-down list enables you to select the correct command termination for a specific instrument.
Almost all new instruments use a new line character as the instruction terminator, so the default entry in the
drop-down control is \n , a common representation for new line. The other termination sequences involve the use of
the carriage return character, commonly represented by the \r symbol.

Click Send and Receive to send an instruction that results in the instrument placing an immediate response on the
interface bus. Generally, this type of instruction ends with a " ? " character.

For example, the IEEE-488.2 standard command for an instrument identification query is *i dn? . To send an
instrument identification query from the server to an instrument, choose the setting shown in the following figure, and
click Send and Receive to send *i dn? to the instrument and display the response.

B Note
This dialog can only read instrument response data in text format. Attempting to read a response that contains
binary data will result in an error.

HCE
Server [localhost 4790 Help

Select Instrument Command or Cuery

AEINSTR »|  Rehesh “idn Y -]

TimeouwtinmS  EOL Sequence

5000 | -|

Send and Receive | Send Command | Bead Rezponze | Send Device Clear |

Seszsion History Clear Seszzion Higtory |

GRIBO:E:IMSTR »» “idn?
GRIBO:1E:IMNSTR <« Agilent Technologies EG3584 U540210024.4.04.25

Click Send Command to send a command that does not prompt a response. For example, use this button to send
*. cl s to clear the instrument buffer.
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Click Read Response to read data from an instrument independent from a transmitted instruction. Some instruments
can sample continuously. To get several samples of information, send a command to start the instrument sampling,
then select the Read Response button several times.

Click Send Device Clear to send the IEEE-488 bus command for selected device clear. This command is a high-priority
bus command (superseding ordinary instructions) that forces an instrument to abort its current function and return to
an idle state in order to regain control over an instrument.

The Session History is an edit field that logs the instructions you send to an instrument and the instrument's
responses to those commands. To delete the contents of this field click Clear Session History .

Measurements Menu

The Measurements menu provides access to behavioral modeling, S-parameter, spectrum, and voltage waveform
measurements located on the server. For more information, see Understanding the Measurement Panels.

For a list of instrument model humbers compatible with the measurements provided by the Connection Manager
Measurement panels, in the Connection Manager client window, click Help > Supported Instruments... .

D Note
Though the N5230A PNA network analyzer can measure S11 through S44 via Connection Manager, Connection
Manager cannot be used to make differential measurements.

Windows Menu

The Windows menu provides control over the function of the measurement panels contained within the client main
window.

Choose Tile to resize the contained dialogs, arranging them so that they fill the entire client window without
overlapping.

Choose Cascade to arrange the contained dialogs so that they overlay each other with the upper left corner of each
dialog offset down and to the right of the dialog it covers.

Help Menu

The Help menu contains access to documentation and support, as well as access to server diagnostics and a list of
supported instruments. For more information, see Connection Manager Server Diagnostics.
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Managing the Set Server Dialog from the Client

The check box labeled Do not prompt me again enables you to select whether the server connection dialog displays
when you select any of the entries in the Server, Instruments, or Measurements menus.

Selecting this check box directs all further activities to the server identified when you dismissed the Set Server dialog.
Leaving this box cleared, causes the CM client to display the Set Server dialog every time you select from the Server,
Instruments, or Measurements menus.

B Note

In a case where a client is connected to several different servers, leave this check box unselected. You can
have multiple instances of the measurement panels and discovery dialogs point to multiple servers.

The information governing whether the Set Server dialog is displayed is stored in the XML file named
CM_InitConfig.cml, under the < ADS Home > /hpeesof/config directory. The file contains the following command line:
<Msnt ClientlnitConfig StartupD gChecked="0" RenobteHost="I|ocal host" Port="4790" ServerD gChecked="0"
/>

The ServerDIlgChecked value determines whether the Set Server dialog is displayed. Entering O displays the dialog,
entering 1 suppresses it.

This file also records the default value of server host and port number.

Understanding Application State Files

Using the File menu you can save and recall application state and exit the client.

By default, Connection Manager stores its application state in the project data directory as an XML file. You can also
store application state data in a user-defined directory.

Following is an example of a Connection Manager application state file.

- <MsmtdientConfig Version="1.0" RenpteHost="Iocal host" Port="4790" Server Sel ect ed="0">
<I nst Expl orer RenoteHost="1ocal host" Port="4790" />
- <Measur enent s>
- <SParnB8753 Renpt eHost ="1 ocal host" Port="4790">
<Vi saRsrc Val ue="GPI BO: : 16: : | NSTR' />
<Querylnstld Val ue="0" />
- <Sel ect Measur enent s>

<S11iMsnt Val ue="1" />
<S12Msnt Val ue="1" />
<S13Msnt Val ue="0" />
<S21Msnt Val ue="1" />
<S22Msnt Val ue="1" />
<S23Msnt Val ue="0" />
<S31Msnt Val ue="0" />
<S32Msnt Val ue="0" />
<S33Msnt Val ue="0" />

</ Sel ect Measur enent s>

- <ExportTextFile Val ue="0">
<Fi | eType Val ue="0" />

</ Export Text Fi | e>

<Dat aSet Nane Val ue="Ag8753" />

<Bl ockNane Val ue="All4" />

</ SPar nB753>
</ Measur enment s>
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</ Msnt d i ent Confi g>}}

Understanding the Measurement Panels

Measurement panels are measurement-specific, not instrument-specific. Because these dialogs do not interact with
schematics, the Connection Manager Client window manages and groups the measurement panels.
All measurement panels have Measure and Help buttons.

Click Measure to execute the configured measurement.

Click Help to access Connection Manager documentation.

Common Functional Groups

Many of these measurement panels have a common subset of controls used to collect the information needed to
record an ADS dataset. Some measurement panels provide a limited set of controls to setup an instrument and gather
data from a manually configured instrument.

Some measurements do not require the use of these programmatic controls. For example, the S-parameter
measurements assume a valid network analyzer calibration. Changing an instrument configuration programmatically
could invalidate the calibration. In this instance, the measurement control dialog omits controls that could cause the
instrument to make a measurement without a valid calibration.

Select Instrument

Select Inztrument

GRIBO:TNSTR - | Refresh [ Overnide instrument model check

Every measurement panel contains the Select Instrument group. It is used to query, view, and select connected
instrumentation, control the automated instrument identification process, and in some cases reset instrument states.

Refresh

Click Refresh to repopulate the drop-down list with the latest instrumentation configured on the server.
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Select Instrument

Use the drop-down list to view the connected instrumentation and choose an instrument for a given measurement.
The information displayed in the list is the same information found in the Remote Instrument Explorer.

Override instrument model check

Select the check box labeled Override instrument model check to disable the automated instrument identification
process. Leaving this check box deslected queries an instrument for its identification string and verifies that the
instrument is a particular model number or belongs to a particular family at the beginning of the measurement.

Select this check box if an instrument's instruction set is compatible with a given instrument or family, but is not
specifically listed in the measurement. Deselect this check box if a measurement must be performed by a specific
model number or family of instruments.

For example, to make a voltage waveform measurement using an instrument with an Agilent 86100-compatible
instruction set, selecting this check box would allow the measurement to execute on the unlisted oscilloscope without
returning an error.

D Note
Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may result in inaccurate measurement data.

Select Measurement

Every measurement panel contains the Select Measurement group, used to select a specific measurement or series of
measurements. The dialog displays measurements appropriate to the instrument driver: S-parameters, trace,
channel, and memory.

Select All

Click Select All to choose all available measurements.

Clear All

Click Clear All to deselect all selected measurements.
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Save Dataset

Every measurement panel contains the Save Dataset group. It is used to construct an ADS dataset from measured
data.

Save Datazet

Dataset Name | Browse.., |

Block Name | CM

The entry field labeled Dataset Name contains the file name of the destination ADS dataset. Every measurement
creates a temporary dataset file in the project data directory.

When a measurement completes successfully, the temporary dataset file is renamed as specified in the Dataset Name
field. When a measurement does not run to completion, the temporary dataset file will remain in the project data
directory to try to preserve as much information as possible.

Browse...

Click Browse... open the Export dialog where you can choose a folder and select an existing file name or enter a file
name for the exported measurement data. In the case where you specify the name of an existing dataset, its contents
will be replaced with the contents of a new measurement.

The Block Name field holds the name of a containing variable that holds the actual measurement variables. This
enables you to select measurement values of the same name from different measurement runs. Normally, a
measurement creates a dataset, holding a single block filled with all the variables representing the various pieces of
measured data. There are occasions where this is not true.

Each measurement creates a temporary dataset file prefixed by two underbars (_) in the _\Protect Data directory.
Upon successful completion of the measurement, the temporary dataset file is renamed using the value entered in the
Dataset Name: field.

Though not specifically part of the dataset group, selecting the Measure button confirms the measurement
configuration before executing the hardware commands. The client tells the server to make the measurement, sending
the information gathered in the measurement panel as configuration data.

Understanding S-Parameter and Behavioral Modeling Measurements

This section explains S-parameter data formatting, dataset and data file referencing, and an overview of the
measurement panel functionality.
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B Note

Connection Manager can only use S-parameter data that contains both magnitude and phase information, as
found in vector network analyzers. Scalar analyzers do not provide information in a format suitable for use
with Connection Manager.

Matrix and Non-Matrix Variable Formatting for S-Parameter Data

Depending on the available instrumentation, Connection Manager can perform 2-, 3-, and 4-port S-parameter
measurements.

The format of the variable names stored in an S-parameter dataset depend on the measurements selected. There are
two variable name formats used in S-parameter datasets:

e a matrix notation
e a non-matrix notation

The matrix notation is used when you select all measurements needed to fully populate a matrix for a given number of
ports, the minimum number being two ports.

The matrices for a 2-port measurements will contain the variables:

S[1,1] S[1,2] S[2,1] S[2,2]

3-port matrices contain:

S[1,1] S[1,2]1 S[1,3] S[2,1] S[2,2] S[2,3] S[3,1] S[3,2] S[3,3]

4-port matrices contain:

S[1,1] S[1,2]1 S[1,3] S[1,4] S[2,1] S[2,2] S[2,3] S[2,4] S[3,1] S[3,2] S[3,3] S[3,4] S[4,1] S[4,2] S[4,3] S[4,4]

Non-matrix formatting is used for individual S-parameter measurements, or measurements that do not contain all of
the 2 or 3-port data. In non-matrix formatting, the variable names take the form s1_1, s1_2, s2_1, s2_2 and so forth.

You must differentiate between a fully-populated and a partially-populated matrix. Expression evaluators in the Data
Display Server and in simulation components make simplifying assumptions when they encounter variables named
using matrix notation. Those assumptions enable faster lookup for matrix variables, but depend on a particular layout
and ordering of the stored data. The absence of data within the matrix data cause the matrix evaluation expressions
to fail.

S-Parameter Data Acquisition

The most common reason for measuring S-parameters is to use the data in an S-parameter simulation. To be useful
in an S-parameter simulation, the measured data must be stored in the dataset as real and imaginary pairs. Because
the instruments will return data in differing formats (depending on the analyzer's data display configuration), when
the Connection Manager reads the measured data from the instrument, it will momentarily switch the display to a
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Smith chart. When displayed this way, the instrument returns data in real and imaginary pairs required for an ADS
dataset.

B Note

This momentary change in display format does not compromise the measurement integrity. When finished
gathering data, Connection Manager restores the instrument data display to its original format.

Earlier versions of Connection Manager acquired S-parameter data prior to the analyzer formatting the data for display
on the analyzer's front panel. With ADS 2004A, Connection Manager now acquires S-parameter data after the data
has been formatted to display real and imaginary pairs (represented as a Smith chart).

If you require a particular S-parameter representation, configure the instrument in the same manner you want the
measured data stored in the dataset. If you want to store raw data, turn off corrections on the instrument. If you want
to store corrected data, turn on corrections on the instrument. If you want to store data that includes electrical delay,
set the instrument to a display mode that includes electrical delay and apply the required delay. This is a change from
previous versions of ADS, where only corrected data was stored.

Because the Connection Manager reads S-parameter data from the display buffer, any electrical delay you add to the
measurement will be included in the data stored in the dataset. When displayed in an ADS data display window Smith
chart, you can observe the electrical delay. DDS displays that do not show phase information, such as the rectangular
plot displaying the data in dB, will look the same as any instrument display that doesn't show phase information, for
example the Log Magnitude format.

Sweep Configuration

Connection Manager will not automatically acquire a new data sweep when asked to return measured data.

If the instrument is in hold mode, executing a measurement from the client returns the last data stored to the
instrument memory.

To gather all of the data traces from the same sweep, configure the instrument to take the required measurements
using the required conditions, then trigger a single sweep on the instrument. When the sweep is complete, the
instrument enters hold mode, allowing the transfer of all the trace data into a dataset without taking a new sweep.

The single exception to this is the PNA power-swept measurement. When asked to retrieve data, the PNA power-swept
measurement will always initiate a new sweep.

If you are using the 8753 power-swept measurement, make sure the instrument is set to trigger continuously.

Exporting S-Parameter Data to Text Files
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The S-parameter measurement panels provide data export functionality through the Export Data group box.
There are five File Type options:

AmplifierP2D (use with AmplifierP2D circuit component)
AmplifierS2D (use with AmplifierS2D circuit component)
AmpSingleCarrier (use with AmpSingleCarrier circuit component)
GainRF (use with GainRF signal processing component)
All-4-Formats

Data exported to an S2D file must meet the following requirements:

e The file must contain at least one GCOMPx x:{1,2,...,7} block
¢ It may contain an ACDATA and/or and NDATA block (and/or an IMT block)
e It may be multi-dimensional. For example, it may contain VAR statements above each basic S2D block.

The contents of such an S2D file may be distributed to the following models in the following capacities:

e AmplifierS2D can read multi-D S2D files (including ACDATA, GCOMPx and NDATA) blocks and is highly
recommended for generic use. It is mounted on top of Amplifier2 so all FILE-mode properties of the latter are
preserved. See also, AmplifierS2D component documentation.

e Amplifier2 can read 1-D S2D files (only reads the GCOMPx block) if placed in FILE-mode. Its small signal
parameters and noise parameters need to be supplied manually at run time. Less effective for using direct
instrument read data. See also, Amplifier2 component documentation.

e Both AmplifierS2D and Amplifier2 can create odd order harmonics and IMDs to some degree of accuracy and
model nonlinear noise, but cannot handle gain expansion very well because of the polynomial curve fitting
constraints. See also, AmplifierS2D component documentation.

AmpSingleCarrier is not recommended because it contains a subset of the functionality available with AmplifierS2D
(for example, AmpSingleCarrier does not provide harmonic modeling). If non-poly fitted single carrier modeling is
required, AmplifierP2D handles full 2-port S-parameters. See also, AmpSingleCarrier component documentation.

AmplifierP2D is recommended for all single carrier applications. It can handle small signal noise and full 2-port large
signal nonlinearity. It does not have problems handling arbitrary compression curves because it data fits by direct
interpolation of P2D file data. See also, AmplifierP2D component documentation.

Behavioral Modeling (Power Swept S-Parameter) Measurement Panels

This measurement is available for two network analyzer families, the Agilent 8753/8722/8720/8719 Network Analyzer
Family and the Agilent ENA B and PNA Series Network Analyzer Families .

B Note
Instruments in the Agilent 8753/8722/8720/8719 Network Analyzer Family have varying capabilities to make
S-parameter measurements. Instruments with an " ET " designation have only transmission and reflection test
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sets, and are not capable of making a full suite of S-parameter measurements. Instead, they measure
transmission and reflection only on one port.

The Power Swept S-Parameter Measurement panels contain five sections.

E Agilent Connection Manager Client
Eilx Server [nstruments Measurements Window Help

%Pmr Swept 5-Parameter Measurement - ENA B and PHA& Network Analyzer Families - port 4790 !Eﬂ

Server (locahost
Select Instiument
|GRE216-INETR | Relresh | [ Ovenide instument model check
Select Power Sethngs
Staet PowerfcBin) Stop PoweddBm) Steg(dB)
Piowies Sweeap Sellirg: |.3:. [-1D |]

P2F1 Pomer Offset{dB) [0

Select Meaapuramant
s [ 512

rsa1 [~ 522

Expoit Diasta
™ Expart bo Test File File Type | P20 SDIF Mpid) =]

Fitrﬂﬂel Broge

Save Datamel

Measiee
Distaset Name [evicel_psa11
ke |

Block Hame |I:H elp

Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to the server. You can either
select a VISA identification string from this list or type in any valid VISA identification string corresponding to an
instrument connected to the server. After a new interface is created, use the Refresh button to update the instruments
on the Select Instrument drop-down list.

The check box labeled Override instrument model check determines whether the measurement queries an instrument
for instrument model, its identification number or its identification string, and verifies that the instrument is a
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particular model number or belongs to a particular family. This identification takes place once at the beginning of the
measurement. If you know that a measurement needs to take place only on a certain model number of instrument or
family of instruments, leave this box cleared. If you want to use an instrument whose instruction set is compatible
with a given instrument or family, but is not specifically listed in the measurement, then check this box.

© Note

Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may provide inaccurate results.

Select Power Settings

Use this section to specify the power range over which the stimulation power is swept.

Power sweep always starts from the minimum power and ends at the maximum power. If the specified Start Power is
higher than Stop Power , they are swapped.

If any of the specified power entries cannot be set correctly (usually out of range) during the measurement, the
measurement stops and no data file/dataset is generated.

P2-P1 Power Offset can be set to a non-zero value in order to offset port 2 power from port 1 power. Only the
Amplifier P2D file can reflect the power offset. Other data files and datasets only record the P1 power.

If P2-P1 Power Offset is set to a non-zero value, for example 5 dB, Agilent EB8XX/E83XX/N338X network analyzers
uncouple port 1 and port 2 automatically. However, for Agilent 8753/8722/8720/8719 network analyzers, port 1 and
port 2 must be uncoupled manually. Otherwise, the measurement will warn out and stop.

B Note

Agilent EB8XX/E83XX/N338X network analyzers turn off auto attenuator control during the measurement for
better accuracy.

Select Measurement

Use the check boxes in this section to select the S11, S12, S21, and S22 measurements.

© Note

At least one of the check boxes must be selected to proceed.

Export Data

Use this section to choose a file name and export an ASCII text file.
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There are five File Type options:

AmplifierP2D
AmplifierS2D
AmpSingleCarrier
GainRF
All-4-Formats

Selecting a file type from the drop-down list produces a file in that format. Selecting All-4-Formats generates four data
files, one of each type.

Entering a file name with an extension is not recommended. A .p2d, . s2d, .sc, or .txt is automatically appended to
the File name for each of the file types respectively.

B Note

_ Save Data File_ is only active if the Export to Text File check box is selected.

For more information, see Exporting S-Parameter Data to Text Files.

Save Dataset

Use this section to specify the dataset and block name for saving trace data.

Measure

Select the Measure button to perform the measurement. At this point data is saved in the specified dataset.

© Note

While the measurement is running, the measurement panel is disabled. Upon completion, a Measurement
complete dialog box appears. Select OK to dismiss.

Measurement Results

The following data display shows the typical results from a measurement performed with an Agilent EB364A.
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The following screen shot shows part of the generated MeasuredByAgilentPNA.p2d file performed with the Agilent
E8364A.
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S-Parameter Measurement Panels

2-Port, 3-port, and 4-port S-parameter measurement using one or more instruments from the following network
analyzer families:

Agilent 8753/8722/8720/8719 Network Analyzer Family
Agilent 8712/8714 Network Analyzer Family

Agilent ENA B and PNA Network Analyzer Families
Agilent 8510 Network Analyzer Family

The S-Parameter Measurement panels contain of four functional sections.

E& Agilent Connection Manager Client
Fle Server Instruments Messurements Window Help

g 5-Parameter Measurement - ENA-B Network Analyzer Family - port 4790 !En

Server [localhost

Select Instrument

[ | Refresh [~ Oveiride instument model check

Select Measuement

W 511w 512 [ 513 [ 514
W S21 522 I 523 [ 524
83 [ 532 [ 533 [ 534

Cs [ s42 [543 FSMM

Select 21

Expoit Data

[ Export to Text File File Type I CatiFile - I
File rsme I Brosvse |

Save [atazet

Measume
S— e
Block Name  |CM __Heo |

Select Instrument

Use this section to select and initialize the instrument used for data collection.
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The drop-down list shows VISA identification strings of all instruments connected to the server. You can either select a
VISA identification string from this list or type in any valid VISA identification string corresponding to an instrument
connected to the server. After a new interface is created, use the Refresh button to update the instruments on the
Select Instrument drop-down list.

The check box labeled Override instrument model check determines whether the measurement queries an instrument
for its identification string and verifies that the instrument is a particular model number or belongs to a particular
family. This identification takes place once at the beginning of the measurement. If you know that a measurement
needs to take place only on a certain model number of instrument or family of instruments, leave this box cleared. If
you want to use an instrument whose instruction set is compatible with a given instrument or family, but is not
specifically listed in the measurement, then check this box.

B Note

Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may provide inaccurate results.

Select Measurement

Use this field to select which S-parameter(s) from S11, S12, S13, S21, S22, S23, S31, S32, and S33 are measured.
The S11 measurement uses port 2 as load port, S22 and S33 measurements use port 1 as load port.

4-port measurements are available with the ENA B family of network analyzers. The Select All and Clear All functions
in the Select Measurement section are useful in selecting or clearing all the boxes without having to make individual
measurement selections.

B Note

The ENA family of instruments need to be individually configured to make 4-port measurements. For
information regarding making 4-port measurements, refer to the specific instrument manual.

B Note
At least one of the check boxes must be selected to proceed.

Export Data

Use this section to choose a specific file name and to export an ASCII text file. Use the File Type drop-down list to
choose one of two available file types - CitiFile or Touchstone .

B Note

_ Save Data File_ is only active if the Export to Text File check box is selected.
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Save Dataset

Use this section to specify the dataset and block name for saving trace data.

Measure

Select the Measure button to perform the measurement. At this point data is saved in the specified dataset.

B Note

While the measurement is running, the measurement panel is disabled. Upon completion, a Measurement
complete dialog box appears. Select OK to dismiss.

Measurement Results

The following data display shows typical results from a measurement performed with an Agilent ES364A.
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The following screen shot shows part of a text file generated using the Save Data File feature.
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END
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Understanding Spectrum Measurements

Spectrum measurements are available for three types of spectrum analyzers:

e 856XX Spectrum Analyzer Family
e 859XX Spectrum Analyzer Family
e E444XA PSA Series spectrum analyzers

The Spectrum measurement panel collects frequency domain data into a dataset. To read this data during a

simulation, use the CM VSA E444xA Source component.

D Note

The only differences between the three Spectrum Measurement panels are the title bars and trace names.
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The Spectrum Measurement panels contain five sections.

4 Spectrum Measurement - Agilent E444XA Spectrum Analyzer Family - port 4790 X

Server II::u:thu:ust:#?EEl

Select [nstrument

[ Oweride instrument model check

IGF‘IED::?::INSTH | Refresh | [~ Reszet Instrument on Initizlization

—Select Frequency Settings

7 Usze Cument Instrument Settings

Center Frag L itz Span L itz
™ Center Frequency,/Span [100 |MHz =] 1.0 | MHz =]
Start Fraq Uitz Stop Freqg itz

(+ Start/Stop Frequency [1.998 |GHz +| |2002 [GHz |

—Select Measurement
[v Trace1

[ Trace 2
[v Trace 3

—Save Datazet

Meazure
Datazet Mame Itest444><.f3. Browse... | _

Block Name  |CM Help

Select Instrument

Use this section to select and initialize the instrument used for data collection.

The Select Instrument drop-down list shows the VISA identification strings of all instruments connected to the server.
You can either select a VISA identification string from this list or type in any valid VISA identification string
corresponding to an instrument connected to the server. After a new interface is created, use the Refresh button to
update the instruments on the drop-down list.

110



Advanced Design System 2008

The check box labeled Override instrument model check determines whether the measurement queries an instrument
for its identification string and verifies that the instrument is a particular model number or belongs to a particular
family. This identification takes place once at the beginning of the measurement. If you know that a measurement
needs to take place only on a certain model number, leave this box cleared. If you want to use an instrument whose
instruction set is compatible with a given instrument or family, but is not specifically listed, then check this box.

B Note

Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may provide inaccurate results.

Reset instrument on initialization check box

Select this check box to reset the spectrum analyzer to a preset state before executing a measurement.

Use this function when the measurement instructions would otherwise be invalid given the current the spectrum
analyzer configuration.

If the Reset Instrument on Initialization check box is selected, the instrument is reset, any prior setup is lost, and the
instrument returns to the factory default state. This is used in cases where the instructions a measurement sends to
an instrument are not valid for the instrument configuration.

Select Frequency Settings

The Frequency Selection section is used to specify the frequency range over which the spectrum measurement is
performed.

Selecting Use Current Instrument Settings performs a spectrum measurement over the last specified range. If the
Reset Instrument on Initialization check box (in the
Select Instrument section) is also selected, then the measurement is performed over the factory default range.

Selecting Center Frequency/Span defines a new frequency range. The values entered in the Center Freq and Span
fields and the values selected in the Units drop-down lists must define a valid frequency range (Center Freq > 0, Span
> 0, Center Freq - 0.5 x Span = 0), otherwise the measurement will stop.

Selecting Start/Stop Frequency defines a new frequency range. The values entered in the Start Freq and Stop Freq
fields and the values selected in the Units drop down lists must define a valid frequency range (0 < Center Freq <
Stop Freq), otherwise the measurement will abort.

B Note

Defining a new frequency range using the Center Frequency/Span or the Start/Stop Frequency radio buttons
may return unexpected results in the case where some traces are frozen . Traces can be in two states: an
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update state , where each new sweep updates the trace in some way (when Clear Write , Max Hold , or Min
Hold option is selected) or a frozen state , where each new sweep leaves the trace unchanged (when the View
option is selected). If the View option is selected and new frequency range defined is not the same as the one
with which the trace was captured before being frozen, the frequency axis of the trace read corresponds to the
new frequency range and will be incorrect.

Select Measurement

The Measurement Selection area is used to select which traces are read. The Agilent 856XX family supports only two
traces, whereas the Agilent 859XX and E444XA families support three traces.

 Note

At least one of the check boxes in this area must be selected to proceed.

Save Dataset

Use this section to specify the dataset and block name for saving trace data.

Measure

Select the Measure button to perform the measurement. At this point data is saved in the specified dataset.

B Note

While the measurement is running, the Measurement panel is disabled. Upon completion a Measurement
complete dialog appears. Select OK to dismiss this dialog.

Measurement Results

These are the results from a measurement performed using an Agilent E444XA and the setup shown earlier. For this
measurement, Tracel was set to Max Hold and Trace3 was set to Min Hold.
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Understanding Voltage Waveform Measurements

Voltage waveform measurements are available for the following oscilloscopes:

e Agilent 86100A oscilloscope
e Agilent 5462X and 5464X Oscilloscope Families
e Agilent 5485X and 5483X Oscilloscope Families

The Agilent 86100A, 5462X, and 5464X oscilloscopes require manual measurement configuration from the instrument
front panel.

The Agilent 5485X and 5483X oscilloscopes can be configured from the measurement panel.

Measurement Panels Requiring Manual Measurement Configuration
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The measurement panels under this menu selection create datasets where the Y-axis values represent sampled
voltage data and the X-axis values represent the times at which each voltage sample was taken.

Use the CM Infiniium 548xx Sourcel and CM Infiniium 548xx Source?2 components to read the data during a
simulation.

Eﬁgﬂenl Connection Manager Client Eﬁl@

File Server Instruments Measurements ‘Window Help

g‘lulta.ge Waveform Measurement - Agilent 5462X and 5464X Oscilloscope Families - port 4790 HEE
Sewver |locakost

Select Instrument

|GPIBZ:7AINSTR = Rehesh I™ Ovenide instrument model check

Select Measurameant
[T Channel 1 [~ Chanrnel 2

Save Datazel

Dataset Mame | Browse, .. m]
Block Name | CM Heo |

Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to the server. You can either
select a VISA identification string from this list or type in any valid VISA identification string corresponding to an
instrument connected to the server. After a new interface is created, use the Refresh button to update the instruments
on the Select Instrument drop-down list.

The check box labeled Override instrument model check determines whether or not the measurement queries an
instrument for its identification string and verifies that the instrument is a particular model number or belongs to a
particular family. This identification takes place once at the beginning of the measurement. If you know that a
measurement needs to take place on a certain model number of instrument or family of instruments, leave this box
unselected. If you want to use an instrument with an instruction set compatible with a given instrument or family, but
not specifically listed, then select this check box.

B Note
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Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may produce inaccurate results.

Select Measurement

When stored in the dataset, each measurement selected creates a variable named according to the name assigned to
the measurement, Channelx or Memoryx in the case of the Agilent 86100A oscilloscope or Channel 1 - Channel 2 in

the case of the Agilent 5462x and 5464x oscilloscope families.

The Voltage Waveform Measurement - Agilent 86100A Oscilloscope dialog reads channel and memory data from an
Agilent 86100A oscilloscope. Some applications use the TDR data captured by this instrument. To do this, select the

channel that displays the TDR trace.

 Note

At least one of the check boxes in this area must be selected to proceed.

Save Dataset

Use this section to specify the dataset and block name when saving trace data.

Measure

Select the Measure button to perform the measurement. At this point data is saved in the specified dataset.

B Note

While the measurement is running, the Measurement panel is disabled. Upon completion a Measurement
complete dialog appears. Select OK to dismiss.

Voltage Waveform Measurements Using 5483X Family Oscilloscopes

When using these oscilloscopes with Connection Manager, all measurements must contain equal humbers of trace data

points.

B Note

This measurement requires the instrument to have firmware revision A.02.30 or later. To view the firmware
revision, on the main instrument menu, click Help > About Infiniium . For firmware updates, visit the Agilent

web site.
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Matching Numbers of Trace Data Points

These instruments require datasets to have all the independent variables mapped over the same dependent variable.
If you select more than one measurement in the client window, all the selected measurements must return the same
number of trace points.

For example, if you select Channel 1 and Memory 1 it is important that Memory 1 contain the same number of trace
points as Channel 1 . If the number of trace points differ, store the data in separate datasets.

When copying a waveform to memory, follow these steps to set the memory trace to have the same number of points
as a display trace.

1. From the instrument's Setup menu, select Waveform Memory... .
2. In the Waveform Memory Setup dialog, select Load from Waveform... .
3. In the Load Waveform Memory dialog, select the All Data radio button.

E|Ie Control - Setup - Measure Analyze - Utilities Help E:SEﬁM_
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Measurement Panels With Client-Based Measurement Configuration

Connection Manager offers client-based measurement configuration using Agilent 5483XB and 5485XB Oscilloscope
Families. This measurement panel has extensive instrument control capabilities in addition to the capability to store
downloaded waveforms. The panel groups the data gathering and instrument control functions into related tabs.

The buttons near the bottom of the panel download waveforms, send setup information to the instrument, send setup
information to the instrument, then immediately perform a download, dismiss the dialog, and display context-sensitive

help.

B Note
This measurement requires the instrument to have firmware revision A.02.30 or later. To view the firmware

revision, on the main instrument menu, click Help > About Infiniium . For firmware updates, visit the Agilent

web site.
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E Agilent Connection Manager Client

File Server Instruments Measurements ‘Window Help

4 Yoltage Waveform Measurement - Agilent 5483xB and 5485x Oscilloscope Families [ =] B

Server II::u:thu:ust 4790

Select Instrurnent IEF‘IBD::F"::INSTH| LI Refrezh |

Data Storage IEhannaIEattings I Timebase Settings | Trigger Settings | Memory Settings | Advanced

— Select Waveformlz)
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Select Instrument

Use this section to select and initialize the instrument used for data collection.

The drop-down list shows the VISA identification strings of all instruments connected to the server. You can either
select a VISA identification string from this list or type in any valid VISA identification string corresponding to an
instrument connected to the server. After a new interface is created, use the Refresh button to update the instruments
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on the Select Instrument drop-down list.

© Note

Measurements have only been tested with the instruments identified in the measurement panel. Using an
unlisted instrument may produce inaccurate results.

Data Storage Tab

Data Storage | Channel Settings Timebaze Settings | Trigger Settings | Memomy Settings | Advanced

Select Waveform(z)

¢ Charnel1 [ Channel2 [ Channel 3 [ Channel 4 Select Al

[~ Memay 1 [ Memary2 [ Memoryd [ Memory 4 Clear &l |

Save Dataset

D ataset M ame |"~J'|:|ItageWavefl:urm Browse...

Select Waveform(s)

Like the manually configured oscilloscope measurement Select Measurement group box, the Channel and Memory
check boxes select the data traces to store in a dataset.

The measurement stores these traces with dataset variable names identical to those used in manually configured

oscilloscope measurements.
Select All and Clear All are convenient ways to select and exclude all data and memory channels from data download,

respectively.

Save Dataset

Use this section to specify the dataset when saving trace data. This measurement does not include a block name field.
In addition to being able to type the name of a dataset file into the Dataset Name field, the Browse... button will
display a file selection dialog that you may use to select an existing data or specify a new one.

Channel Settings Tab
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Data Storage | Channel Settings | Timebase Settings | Trigger Settings | Memoary Settings | Advanced

Channel 1 Channel 2 | Channel 3 | Channel 4 |

v Include panel contents in instrument upload
v Dizplay channel 1

Scale MWalts / divizion]

i v =

Offzet

0 v x|

This tab contains additional tabs that allow control of the instrument's vertical scale setup for channels having a
physical input connector. Each acquisition channel is controlled through a separate tab labeled Channel 1 through
Channel 4 .

Every control tab contains an Include panel contents in instrument upload check box. When selected, the contents of
the tab get transmitted to the instrument when you click the Upload Settings . For example, the Channel 1 tab
contents will be transmitted to the instrument when the panel is configured as it is in the preceding screen shot.

Each channel is controlled independently, as are all memories. This allows adjustment of particular instrument
settings, while leaving all others unchanged.

The Display channel X check box determines whether or not the instrument will display the associated trace on its
screen. Selecting a channel for waveform download overrides this setting. For example, if you turn off channel 2, but
select it for download, the oscilloscope will display channel 2 following the data download.

The Scale field sets the associated channel's vertical scale. The number in this field corresponds to the instrument's
Volts/division setting for a given channel.

The Offset field sets the vertical value that is represented at the center of the display for the selected channel. Offset
parameters are probe and vertical scale dependent.

Timebase Settings Tab
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Diata Storage | Channel Settings  Timebase Settiings

I Include panel contents in instrument upload
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Memony Setting: | Advanced

The Timebase reference drop-down list selects the location of the time zero point on the instrument display. Left puts
time zero at the left edge of the display. Center puts time zero in the middle of the display. Right puts time zero at the
right edge of the display. Anything to the left of time zero is data captured before the trigger event.

The Timebase scale field sets the instrument's horizontal scale. This field corresponds to the instrument's time/division

setting.

The Timebase delay field sets the time interval between the trigger event and the delay reference point.

Trigger Settings Tab

Data Storage | Channel Settings | Timebase Settings

[ Include panel contents in ingtrument upload

Trigger Settings

Trigoer mode | Auta

Trigger zource | Chanrnel 1

Trigger slope | Pasitive [ising edge)

Trigger holdoff |80 | ns
Trigger hysteresis | Normal |
Trigger Levels

External |0 v v
Chatel 1 |0 i v
Channel 2 |0 v v
Channel 3 |0 (v |
Channel 4 |0 v |

Trigger Settings

Memon Settings | Advanced
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The Trigger Settings group controls how the instrument takes a sweep.

When Trigger mode is set to Auto , the instrument is in free-run mode, requiring no trigger event to take a sweep.
When in Triggered mode, the instrument will continuously take sweeps, as long as trigger conditions are met. When in
Single mode, the instrument will take one sweep when trigger conditions are met and then stop sweeping.

The instrument can use any of the active channels, the Aux connector on the back of the instrument ( External ) or
the AC power ( Line ) as the trigger source.

The settings in the Trigger levels group determine the voltage value at which the instrument will take a sweep when
the associated trigger source is active.

The Trigger slope setting determines whether the instrument considers the trigger point to be the rising or falling edge
of the signal selected as the trigger source.

Trigger holdoff specifies the amount of time the oscilloscope should wait after receiving a trigger before enabling the
trigger again.

Trigger hysteresis specifies the trigger hysteresis (noise reject) as either Normal or High Sensitivity. Normal sensitivity
adds hysteresis to the trigger circuitry for rejecting noise and should be used for waveform frequencies at or below 4
GHz. High Sensitivity lowers the hysteresis of the trigger circuitry and should be used for waveforms frequencies
above 4 GHz.

The Trigger Levels group specifies the voltage level at which the instrument will take a sweep when the corresponding
trigger source is active.

Memory Settings Tab

Drata Storage | Channel Settings | Timebaze Settings | Trigger Settings Memory Settings | Advanced

M ermany 1 |Memnr_l,l2 |I'v1&mu:ur_l,l3 |Memu:ur_l,ld |

[ Include panel contents in instument upload

[ Dizplay mermany 1

¥ Range [100 lms v
¥ Offset |0 lps |
Y Range |200 v |
Y Offset |0 v |

This tab contains more tabs that control each of the instrument's waveform memories.
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The Display memory X selection determines whether the instrument will display the contents of the corresponding
waveform memory. This setting is overridden by selecting to download the associated waveform memory trace.

The X Range field sets the X-axis (horizontal) range for the selected waveform memory's display scale. The horizontal
scale is the horizontal range divided by 10.

The X Offset field sets the X-axis (horizontal) position for the selected waveform memory's display scale. The position
is referenced to center screen.

The Y Range field sets the Y-axis (vertical) range for the selected memory. The vertical scale is the vertical range
divided by 8.

The Y Offset field sets the Y-axis (vertical) position for the selected waveform memory. The position is referenced to
center screen.

Advanced Tab

Data Storage | Channel Settings | Timebase Settings | Trigger Settings | Memory Settings | Advanced

[ Overide instrument model check

[ Perform autozcale before acquinng trace data
Time to wait to acquire excluzive instrument lock [zeconds) |2

Time to wait for waveform transfer [zeconds] 10

Save Instrument State. . | Hecalllnstrumentﬁtate...|

Reszet [nstrument | Clear |nstrument Status |

When selected, the Perform autoscale before acquiring trace data check box causes the instrument to perform an
autoscale operation before downloading the waveforms you have selected on the Data Storage tab. Autoscale is a
convenient way to have the instrument determine the optimal settings for displaying the waveforms present on the
input connectors.

The Time to wait to acquire exclusive instrument lock check box is an advanced setting intended to allow you to
determine how long to wait for a shared instrument to become available for your exclusive use. If two clients want to
use the same instrument at the same time, the instructions getting to the instrument would be intermingled between
the different clients. To prevent this intermingling of instructions, the server locks an instrument during the time a
client is actively communicating with that instrument. When a client is done, the server unlocks the instrument. This
field specifies how long to wait for a shared instrument to become unlocked (thereby granting access to it) before
giving up.

The Time to wait for waveform transfer field specifies how long to wait for an instruction sent to the instrument to
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complete its task before deciding that the instrument will most likely never complete the task. For example, an
instrument is set to trigger on an external event and the event is expected to occur within 10 seconds. If that event
never occurs, the measurement would hang indefinitely. Use this field to specify how long to wait before giving up.

© Note

Increase this value when downloading large waveforms that may take a long time to transfer out of the
instrument.

Clicking Save Instrument State records the instrument's learn string (as specified by the IEEE-488.2 specification) into
a data file. Use this function to save redoing a complicated instrument configuration. If undesired adjustments are
subsequently made to the measurement configuration, simply recall the stored setup into the instrument by clicking
Recall Instrument State .

Recall Instrument State allows you to select a file containing a previously-stored instrument state to be sent back to
the instrument.

Clicking Reset Instrument State sets the instrument to its default state by issuing the IEEE-488.2 standard * RST
command.

Clicking Clear Instrument Status clears the error status bit in the instrument's status byte by sending the IEEE-488.2
standard command *CLS . Use this to clear an error caused by a previous instruction that timed out.

Use the CM Infiniium 548xx Sourcel and CM Infiniium 548xx Source2 components to read the data and to configure
the Infiniium scope during a simulation.

Download Waveform(s)

Select the Download Waveform(s) button to capture the selected traces from the instrument and store the data in the
dataset. See Matching Numbers of Trace Data Points for important information regarding waveform memory trace
acquisition.

Download Waveform(s) is active only when the following conditions are met:

e One or more data or memory channels has been selected for download.
e The Select Instrument drop-down list contains an entry.
e The Dataset Name field contains an entry.

Upload Settings

Every control tab includes an Include panel contents in instrument upload check box. When selected, the contents of
the tab are transmitted to the instrument when you click Upload Settings .
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For example, the Channel 1 tab contents will be transmitted to the instrument when the panel is configured. Each
channel is controlled independently, as are all memories.

This allows adjustment to some instrument settings, while leaving all others unchanged.
Upload Settings is active only when one or more of the Include panel contents in instrument upload check boxes are
selected.

Upload then Download

Clicking Upload then Downloa d configures the measurement, acquires the trace or memory data, and saves the data
in a dataset. Upload then Download is active only when both the Download Waveform(s) and Upload Settings buttons
are active.

Done

Click Done to close the measurement panel.

Help

Click Help to access Connection Manager documentation.
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